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Technical Support

For any technical assistance related to Compass 2.0 please address your queries to 
compass.support@honeywell.com

Symbol Definitions
The following table lists those symbols used in this document to denote certain conditions.

Asia Pacific Honeywell Asia Pacific Inc.
Hong Kong

+852-2405-2323

Europe Honeywell Security
The Netherlands

+31 299 410 200

For more contact information see http://www.security.honeywell.com/international

Symbol Definition

ATTENTION: Identifies information that requires special consideration. 

TIP: Identifies advice or hints for the user, often in terms of performing a task. 

REFERENCE-EXTERNAL: Identifies an additional source of information outside of this 
document. 

REFERENCE- INTERNAL: Identifies an additional source of information within this 
document. 
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Guide Structure
This guide describes the tasks that you can perform using the Compass Downloader tool. The chapters in the guide 
are arranged in an order that helps you get familiarized with the application quickly.

The guide is divided into ten chapters:

• Chapters 1 and 2 include the basic information about the Compass Downloader, such as key features, the 
Downloader menu structure, and Downloader installation.

• Chapters 3 and 4 take you through the Downloader setup and cover those tasks that need to be performed only 
once, such as the modem setup.

• Chapters 5 through 8 cover the activities performed using the Downloader. These chapters include adding and 
modifying customer accounts, communicating with the panel and Central Station, and a listing of on-line 
commands and their descriptions.

• Chapter 9 describes database management utility.

• Chapter 10 gives an overview and description of the new features in Compass 2.0.

• Appendix A describes error conditions, including troubleshooting.
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Compass 2.0 Overview
1.  Introduction

1.1  Compass 2.0 Overview
Compass 2.0 provides you with the tools you need to program and control an alarm system remotely 
from the comfort of your office. You can download and upload alarm control information, compare the 
uploaded and saved information, and view the results on screen or as a printed report. 

Using Compass 2.0, you can program an alarm system at the office prior to installation, or can 
download the programmed information from a remote location, or at the job site using a laptop. You 
can download from a remote location through telephone lines, through IP, or through GSM.

Compass 2.0 System supports both Compass 16 and Compass 2.0 accounts.

Downloader Program Structure
Compass 2.0 consists of three main programs, namely the Shell, the Panel Application, and the 
Communication Server.

When you start the software, the logo is displayed first, and then the Log In screen is displayed. After 
you enter a valid Operator name and password, the Compass “Shell” screen is displayed.

REFERENCE- INTERNAL

For more details on Log on and Log off, refer to 2.3 Logging On and 2.4 
Logging Off.
R2.0 Compass 2.0 User Guide 1
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System / Software Requirements 
Figure 1-1 Compass 2.0 Shell

From the Shell, you can access program-wide options, such as Logout and Exit, Station Data, and 
Operator Setup. You can also configure Customer Accounts.

From the Customer Accounts list, you can access the customer account’s Alarm Control Panel 
configuration.

From the Panel Edit screen, you can go to the Communications Program, connect to a customer’s 
alarm control panel, and execute commands on-line. You can perform activities such as arming or 
disarming the panel; programming the panel configuration (downloading); or uploading configuration 
and settings that were programmed to the panel.

1.2  System / Software Requirements

System Attribute Minimum Recommended

Processor 256 MB RAM 512 MB RAM

Disk Space (Free) 1 GB >1 GB

Monitor Resolution 800 X 600 1024 X 768
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System / Software Requirements 
Compass 2.0 does not support simultaneous windows user sessions:

Scenario#1: Compass may not work, If a user tries to login when another active session is open on the 
same computer.

Application Version

Operating System • Windows 2000-SP4

• Windows XP SP3 -   Home 
Premium, Professonal and Ultimate

• Windows 2003 SP2 - Small 
business server and Standard 
edition 

• Windows Vista SP2 - Home Basic, 
Home Preminum, Business  & 
Ultimate 

• Windows 7- Home Preminum, 
Professional & Ultimate

Note: Not all panels are supported in 
windows Vista and Windows 7 OS. To 
view the list of panels supported by 
MS Vista or Windows 7 OS, Please 
refer to release notes.

Database MS SQL Server 2000 ,MS SQL Server 
2005, MS SQL Express 2005

Note: 

• MSSQL Express is installed in the 
following scenarios:

• If MSSQL Express is not installed, 
the setup installs MS SQL Express 
with Compass 2.0 as the instance 
name. 

• If MSSQL Express is installed with a 
different instance name, the setup 
gives you the option to install the 
Compass 2.0 instance name or use 
the existing instance.

• If SQL Express is already installed 
with compass 2.0 as the instance 
name, the setup uses the existing 
instance.

• Windows 95, Windows 98 and 
Windows NT Operating systems are 
no longer supported by Compass2.0

• MS SQL MSDE and MS Access 
database are no longer supported 
by Compass 2.0.

• Do not delete the Compass folder 
from the computer to remove 
Compass 2.0. This may corrupt the 
registry.

Microsoft Internet Explorer • 5.5 or above
R2.0 Compass 2.0 User Guide 3
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Viewing Product and System Information
Scenario#2: Multiple user sessions across the network is not possible on a server based operating 
system such as Windows 2000 or Windows 2008 server environments

1.3  Viewing Product and System Information
The Help menu of Compass 2.0 Shell provides an “About” box, which provides the product version 
number, installation information, and operator information.

Figure 1-2 Product, Installation, and Operator Information

ATTENTION

Windows 95, Windows 98, Windows NT, SQL MSDE database, and access 
database are no longer supported by Compass 2.0.

Information Description

Product Version Details regarding the product 

Compass 2.0 Version Current version of Compass Build

Database Version Current version of Database

Installation Information Details regarding installation paths

Installation Type Gives the type of Compass 2.0 installation as Server 
or Client

SQL Database Name Database name in the SQL Server to which Compass 
is connected to.
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Viewing a List of Panels Supported by Compass 2.0
Click System Info in the About box to view the system information details.

Figure 1-3 System Information

1.4  Viewing a List of Panels Supported by Compass 2.0
To view the list of panels supported by Compass 2.0, perform the following steps:

SQL Server Name SQL Server Name to which Compass is connected to.

Path of Executables Gives the location of the executables on the system

Operator Information Details regarding the operator

Operator Name Gives the login name of the operator 
R2.0 Compass 2.0 User Guide 5
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Viewing a List of Panels Supported by Compass 2.0
Step Action

1 Click the Unattended icon in the Compass Windows Toolbar. 

The Launch Unattended Server dialog box is displayed. 

2 Click Help. 

Compass 2.0 Windows Downloader window is displayed.

3 Scroll down the list to view the panels supported by Compass 2.0 and the 
panels supported by Compass 16. 
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Getting Product Updates
1.5  Getting Product Updates
You can acquire any future updates through Honeywell directly, or download them from our Internet 
site:

http://www.security.honeywell.com/hsce/

Latest Build and Patch Information
Ademco: Build 1.5.8.0 and last released update Patch – e.g 1.5.8.54 or later.
R2.0 Compass 2.0 User Guide 7
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Setting up Downloader Communications
2.  Communications Setup

2.1  Setting up Downloader Communications
To set up communication with different protocols, you must set up a modem for each protocol in the 
Communication Setup screen.

The list of modems supported in Compass 2.0 for each protocol can be viewed in the Standard Modems 
pane of the Communication Settings dialog box.

Figure 3-1 Communication Settings

2.2  Setting up the Modem

To set up the modem, click  on the Compass Shell toolbar or click File> Communication 
Setup in the Compass Communications screen.

The Communication Settings (Figure 3-1) dialog box is displayed. 
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Setting up the Modem
The modem is set up as follows: 

Parameter Description

Select Company From the list of companies, select the name of the 
company whose panel you are using. If FBII is 
selected, the Interface needs to be configured 
accordingly.

 REFERENCE– INTERNAL: For more 
information on configuring FBII refer to FBII F7702 
Interface.

Modem Settings

Select COM Ports Select the option, ‘ List all COM Ports including virtual 
ports”, to view all the virtual comports along with the 
physical comports available in the system. 

The available COM ports will be displayed in the drop 
down “Select COM Port for Compass”

Click Add or Delete in the displayed window to add or 
delete COM ports. The selected port is used for 
Compass communications.

Standard Modems Based on the protocol selected, the corresponding 
standard modems are displayed. To view details of the 
modem, select the modem and click View.

The View Modem Properties Dialog box is displayed.
R2.0 Compass 2.0 User Guide 9
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Setting up the Modem
Custom Modem To add a new modem that is not in the list, click Add. 
The Add/Edit Modem screen is displayed. Configure it 
as detailed in the section  Adding Modems.

Dial Out Prefix It is a unique number used for identifying the panel from 
which the call comes.

Touch Tone Select this, if you prefer touch tone dialing. The default 
type is Rotary, or pulse dialing.

Speaker On Select this, if you want the speaker on.

Off After Connect Select this, to turn off speaker after connecting.

Modem Volume Set modem volume. Select High, Medium, or Low, from 
the drop-down list.

TCP/IP Port Settings Click to configure TCP/IP port. The configure TCP/IP 
port dialog is displayed.
10 Compass 2.0 User Guide  R2.0
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Setting up the Modem
FBII F7702 Interface
F7702 is a modem interface for use with Compass 2.0. This allows a wider range of modems to be 
used and provides a local mode of operation.

You can connect with the panel remotely or locally depending on the modem configurations in the 
Shell.

The modem configuration screen allows you to type the value for a Remote Code Suffix and a Local 
Code Suffix. In most cases, the default values of **1 for the remote and **0 for the local is used. These 
options exist to accommodate situations where the phone company or your PBX uses **0 or **1.

If the company selected in Communication Settings is FBII, the FBII F7702 Interface must be 
configured as:

Figure 3-2 FBII F7702 Interface 

TCP IP Port Select the TCP IP Ports. To add more ports, click Add. 
To remove ports, click Delete.

Internet/Intranet Controller Type the IPAddress of the Control Server of the 
customer location. 

While communicating over the Internet through 
Alarmnet, enter the AlarmNet-i Website address/URL 
where the Control Server is running, as shown in the 
display (this is set to a default value of 
“controlserver.alarmnet.com”.)

Click OK.

Click Apply, to apply the above settings to the modem.
R2.0 Compass 2.0 User Guide 11
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Setting up the Modem
Adding Modems
Modems can be Standard, shipped with the downloader; or Custom, which you can configure 
yourself.

In case of Standard modems, you can only view properties by clicking View, but cannot modify them.

Parameter Description

Local Code This refers to the code passed to the model F7702 
Interface to place it in local mode. The default of ‘**’ 
should work fine; however, it may be changed to any two 
digits (including * or #) to suit your line needs. This mode 
is programmable on the F7702 Interface. 

 REFERENCE– EXTERNAL: Refer to F7702 
Interface User Guide for programming instructions.

Remote Code This refers to the code passed to the F7702 Interface to 
place it in remote mode. The default of ‘**’ should work 
fine; however, it may be changed to any two digits 
(including * or #) to suit your line needs. This mode is 
programmable on the F7702 Interface. 

 REFERENCE– EXTERNAL: Refer to F7702 
Interface User Guide for programming instructions.

Ring Count It is the number of rings after which the panel would 
answer.

Carrier Duration It is the carrier duration for the F7702 Interface.

Mode Set this to Remote or Local based on whether the 
communications performed with the F7702 Interface are 
remote or local. Select None when the F7702 Interface is 
not being used.
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Setting up the Modem
To add a new custom modem, perform the following steps:

Editing Modems
The Edit and Delete options are applicable only to the Custom Modems. Modem settings that were 
shipped with the Downloader cannot be edited or deleted. 

To edit a modem’s settings, perform the following steps:

Step Action

1 Click Add under Custom Modems in the Communication Settings 
dialog box.

The Add/Edit Modem dialog box is displayed.

2 Type the name of the modem under Modem.

3 Type the modem commands, or select the modem template to be used 
from the Template drop-down. 

If a template is selected, the AT commands, Reset Command, and Max 
Command Length are automatically filled as defined in the template.

4 If your modem supports the Caller ID feature, type the Caller ID 
Command on the Support frame.

5 Click OK.

Step Action

1 Select the modem from the Custom Modems list in the Communication 
Settings window.
R2.0 Compass 2.0 User Guide 13
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Configuring Modem Switch Settings
Deleting Modems
To delete a modem, select the modem from the list box and click Delete. Click OK to confirm the 
deletion.

You can also delete all the Custom modems using the Delete All button.

2.3  Configuring Modem Switch Settings
This section helps you configure modems that have manual switch settings.

2 Click Edit. 

 ATTENTION: The Edit and Delete buttons are disabled if there are no 
Custom Modems. 

3 Edit the modem commands or/and the Caller ID Command.

4 Click OK to save the new commands, or click Cancel to quit without saving.
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Configuring Modem Switch Settings
Hayes Smartmodem 1200 External Modem
Configure the DIP switches behind the modem’s front panel:

Figure 3-3 Hayes Smartmodem 1200 External Modem

Hayes Smartmodem 1200(B) Internal Modem
The rear view of the Smartmodem 1200(B) Internal Modem is illustrated below:

Figure 3-4 Hayes Smartmodem 1200(B) Internal Modem
R2.0 Compass 2.0 User Guide 15
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Mapping Devices to IP
2.4  Mapping Devices to IP
You can add, edit, or delete a mapping of Device to IP address using the Device or Computer Name / 
IP Address function. 

Enter information about all the 7810iR modules that Compass will be connecting to by typing the IP 
address of 7810iR and a Device name to identify it, as described below.

Step Action

1 On the Customer screen menu of the Downloader, select File > Device or 
Computer Name / IP Address.

The Device or Computer Name / IP Address screen is displayed.

2 Click Add in the bottom toolbar of the screen.

3 Type the Device or Computer name details and the corresponding IP address.
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Configuring Station Data
2.5  Configuring Station Data
The Station Data window is used for adding or editing Customer Class description, Station CSID, and 
user defined fields. You can access this window from the File menu of the customer screen. 

Central Station ID
The Central Station Identification number (CSID) serves as the identity of the company that installed 
the control panel. This prevents unauthorized remote access to the panel. This number is transmitted 
by the computer and is verified by the control panel during an attempt to get on-line for downloading. 

The CSID must be of eight characters (consisting of 0-9, A-F) for Ademco panels. Your administrator 
assigns this number. Only the first six characters are used for FBII. Destiny and Focus panels do not 
use this ID. 

When authorized, you can view or change the CSID on the Dialer screen when modifying an alarm 
control panel.

Configuring CSID
To configure CSID, perform the following steps:

4 Click Ok. (When the screen is in Add Mode, the Add button changes to Ok).

Step Action

1 Click File in the menu bar of the Compass Shell.

2 Select Station Data from the menu. 

The Station Data screen is displayed.
R2.0 Compass 2.0 User Guide 17
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Configuring Station Data
3 Click Add. The Class Description field becomes editable. 

4 Type a description (Example: Home User)

The description reflects in the Current Customer Class pane.

5 In the Station CSID field, type your CSID number. 

6 Select OK to save and quit, or Cancel to quit without saving.

 TIP: After an account is saved, the CSID is stored in that account, so 
that a change to the Station CSID does not change the account CSID.

7 If you want to download the current station CSID to all Compass-downloaded 
panels, select Write CSID on Download All. 
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Configuring Station Data
Changing the CSID
To change the CSID of an account, connect to the panel from the Communications screen, click 
Modify and change the CSID on the Dialer screen of the panel. Then download the panel.

In Unattended mode, you can download the current station CSID to all Compass-downloaded panels 
by selecting Write CSID on Download All. This changes the CSID to the new CSID specified in 
Station Data. Clicking the View CSID button in the Dialer of the panel, displays the new station CSID.

This will be applicable for Unsolicited calls but in case of Unattended batches we need schedule a job 
with Change CSID command.

Customizing User-Defined Fields
There are two user-defined fields on the Station Data screen. You can customize these fields, and then 
use them on the Customer Information screen as sort criteria to help organize customer accounts.

As an example, in Figure 3-5, user_defined_field 1 is replaced by Area Code. This change is 
reflected on the customer screen.

Figure 3-5 User Defined Fields

8 Some panels allow multiple attempts by the Downloader to match the CSID. 

To enter alternate CSIDs, perform the following steps: 

Click the Add button under the Alternate CSIDs text box.

The text box is enabled. Type the CSID in the text box. 

Click OK. The new CSID is added to the list of alternate CSIDs. 

You can make changes to the list by using the Edit option. To delete any of 
the CSIDs, select it, and click Delete.

REFERENCE- INTERNAL

For more information on Commands refer to On-Line Commands 8. On-Line 
Commands.
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Configuring Station Data
This field is now displayed in the Sort by list as-well-as in the customer details table heading.

ATTENTION

You can configure or change Station Data only if you have Administrator 
privileges.
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Defining System Operators
3.  System Operators

3.1  Defining System Operators
After setting your communications options, the next step is to define Downloader system operators. 

You can assign different levels of authority to operators, allowing/restricting access to various system 
and control panel operations. 

Figure 4-1 Operators - Access 

Adding New Operators 
To add a new operator, perform the following steps:

Step Action

1

Click  on the Compass Shell screen toolbar to display the 
Operators window.

2 Click Add in the bottom panel of this window.

3 The left pane of the screen changes (compare the figure below with Figure 
4-1) allowing you to type an operator’s name and password. 

The new password must be typed twice—once under New Password, and 
again under Retype Password.
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Defining System Operators
Access Definitions 

4 Select the Access properties for this operator from User Screen Access, 
Subscriber Access, and Other Access.

5 Click OK to save the addition.

Option Allows you to…

User Screen Access View control panel user screen when 
modifying control panel programming.

View User Code View control panel user codes.

Add Users Add control panel user codes.

Modify Users Edit or delete control panel user codes.

Subscriber Access Handle subscriber data.

Add Add new customers to database.

Edit Edit existing customer information.

Delete Delete customers from database.

Modify Panels Access and change alarm control 
information.

Import / Export Import/export Compass accounts.

Other Access
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Defining System Operators
Changing Operator Names 
If you want to change an operator’s name, perform the following steps:

Changing Operator Passwords 
If an operator forgets or wants to change his password, an Administrator can assign a new password. 

To assign a new password, perform the following steps:

Administrator Configure or modify any Compass 2.0 
screen. Without this authority, you cannot 
view the Operator or Station Data 
screens.

Convert Accounts Convert DOS accounts utility is not 
available in Compass 2.0. It is available in 
the Compass 16 bit Shell. This access 
option is available in Compass 16 bit 
since it enables/disables the option 
File->Receiver Group/CS Phone number 
# in Shell.

Restore / Purge Customer Restore or completely purge customer 
accounts.

Print Data Print all alarm control information.

Zone Screen Enabled Access the Zone Information screen for 
the control.

History Screen Enabled Access the History Screen for the control.

Template Screen Enabled Access the Create Templates screen.

View CSID / Proprietary ID in Panels View the Central Station Identification 
Number.

Change CSID / Proprietary ID in Panels Change the Central Station Identification 
Number.

Edit Import Subscribers Change import subscriber options and 
settings.

Communications Communicate with panels.

Step Action

1 Highlight the name to be changed in the Current Operators list of the 
Operator window (refer to  Figure 4-1 Operators - Access ).

2 Type the new name in the text box below.

3 Click Update at the bottom of the Operators screen. 

 ATTENTION: The Update button is enabled when you type a new 
operator name.

Step Action
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Defining System Operators
Updating Operator Information 
You can update or change an Operator’s access status.

To change an Operator’s access levels, perform the following steps:

Deleting Operators
To delete an operator name, select an operator’s name from the Current Operators list and click 
Delete (refer to  Figure 4-1 Operators - Access ). Click OK when asked for confirmation.

1 Click Operators on the Compass Shell screen toolbar to display the 
Operators screen.

2 Select the operator from the Current Operators list in the Operators window.

3 Click Change Password.

The Change Password screen is displayed.

4 Type the new password and confirm by retyping it. 

5 Click OK at the bottom of the screen.

ATTENTION

Only an Operator with Administrator privilege can change the password.

Step Action

1 Click Operators on the Compass Shell screen toolbar to display the 
Operators window. 

2 Select the operator from the Current Operators list in the Operators window.

3 Modify the access levels for the operator.

4 Click Update.
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Adding Customer Accounts
4.  Customer Information
All relevant details of customers and their accounts are recorded and viewed on the Customer screen. 
This data is used for setting your customer database. 

4.1  Adding Customer Accounts
To create a new customer account, perform the following steps:

Step Action

1

Click  in Compass 2.0 Shell toolbar. 

The Customers screen is displayed.

Figure 5-1 Customers

2 Click Add from the Customer Options box at the bottom-right of the screen. 

The Customer Detail screen is displayed.
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Adding Customer Accounts
3 Type the Receiver Group number (up to 6 characters).

4 Type the 3-, 4-, or 10-digit Subscriber Account Number.

5 Type your name, address, and contact numbers in the text boxes provided.

6 Select the Panel Type and Revision.

 TIP: The revision determines which programming fields the Downloader 
displays. If you are uncertain of the revision, select the highest available.

7 Select the Panel Class.

8 Type the Panel Phone Number

9 For panels that support TCP/IP connections, type the 12-digit  MAC address 
of the network device. 

 TIP: This address must match the MAC address of the 7845i module 
that is connected to the panel at the customer location.

10 If you want to print the customer account information, click Print.

11 Click OK.

TIP

If there is any other information that you would like to capture, use the text box 
under Notes, for the purpose. You can type up to 255 characters.
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Changing Customer Account Information
4.2  Changing Customer Account Information
To change the customer account information, perform the following steps:

4.3  Deleting Customer Accounts
To delete Customer Accounts, perform the following steps:

Step Action

1 Go to the Customer screen of Compass 2.0 Shell. 

2 Click the customer account you would like to change.

3 Click Detail in the Customer Options box at the bottom-right of the screen. 

The Customer Detail dialog box is displayed.

4 Make the necessary changes. To print the customer account information 
changes, click Print.

5 Click OK to save the changes, or Cancel to quit without saving the changes. 

Step Action

1 In the Customers screen, click the customer’s name from the list.

2 Click Delete in the Customer Options box at the bottom-right of the screen. 

The following screen is displayed:

3 Select Delete Selected (deletes highlighted account only) or Delete All 
(deletes all accounts displayed in the customer grid). 

4 Click Ok.

ATTENTION

When you delete a customer as described above, the information is not 
completely removed. You must then “purge” the account to completely delete 
it. Refer to section 4.4 Restoring/Purging Customer Accounts for details.
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Restoring/Purging Customer Accounts
4.4  Restoring/Purging Customer Accounts

Purging a Customer Account
You must purge an account before reusing that account and receiver number.

Step Action

1 Go to the Compass Customer Information screen.

2 Click Tools> Restore/ Purge Customer.

The Restore/Purge Accounts dialog box is displayed.

3 Select the account by clicking the required rows in the Rcvr-Acct # column. 

The selected account is highlighted.

4 Click Purge Customer. 

The Purge Records dialog box is displayed.

5 You can choose to purge the highlighted accounts, or all the accounts 
displayed on the screen. Click Ok to purge.
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Searching/Sorting Customer Data
Restoring a Customer Account
To restore a deleted account, select the account and click Restore Customer in the Restore/Purge 
Accounts dialog box. Click Ok to confirm the selection. 

The account is restored.

4.5  Searching/Sorting Customer Data
There are various ways to display customer information based on requirement. 

The Sort By Option
You can use the Sort By option to base your sort on:

• Receiver Account Number

• Last Name

• First Name

• Zip Code

• Business

• Panel Phone

• user_defined_field 1 (Defined as Area Code in the figure)

• user_defined_field 2 

• Create Date

• Modified Date

• Last Communication Date

• Mass Download Job Name

• MAC Address

Go to the Customer screen in the Compass Shell. To the top-left, above the Customer table, you will 
find the Sort By drop-down.

Figure 5-2 The Sort By Option

To select the sort method, click the selection from the drop-down box. As a reminder, the field that you 
selected to sort by is italicized in the Customer table heading.

ATTENTION

A deleted account can be restored. A purged account cannot be restored.
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Purging History Data
Searching for Customer Accounts 
The Search frame is available at the top right of the Compass Shell.

Figure 5-3 The Search Option

You can search by:

• Panel,

• Receiver number,

• Selected Sort Option. 

To search by Panel name, perform the following steps:

To search by Receiver number, type the receiver number and click Search.

The third search option based on the sort option that you selected, as described in  The Sort By 
Option. 

Example: If you have selected the sort option as ‘Panel Phone’, the search option would be ‘Panel 
Phone Begins with’, as shown in Figure 5-3 above. Type the beginning numbers of the Panel phone 
and click Search, to display the search results.

4.6  Purging History Data
An operator with administrative rights can delete history data from the Compass database using this 
utility. This history data is viewed from the History screen within the Panel Modify screen of each 
account.

To access the Purge History screen, perform the following steps:

Step Action

1 From the Panel list, choose the panel.

2 If all revisions of that panel type are required, select All Revs.

3 Click Search. 

The customer table is refreshed showing only the search results.

4 To view all accounts, click All Accounts.

Step Action

1 Click Tools on the Compass Shell screen menu bar. 
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Purging Event Logs
4.7  Purging Event Logs
To access the Purge EventLogs screen, perform the following steps:

2 Click Purge History. 

The following dialog box is displayed:

3 Select All Accounts or Specific Receiver / Account, and the Date Range. 

All Accounts The operator can purge the history for all the accounts 
in the date range selected.

Specific Receiver 
/ Account  

Type the Receiver number and Account number in the 
text boxes provided.

“All History Data” is also enabled in the date range, 
allowing you to purge all the history data of that 
particular account.

4 Click Purge History. All the history data for the selected period, for the 
selected accounts is purged.

5 Click Close to close the dialog box.

Step Action

1 Click Tools on the Compass Shell screen menu bar. 
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Renaming Receiver Group
4.8  Renaming Receiver Group
To rename a receiver group, perform the following steps:

2 Click Purge EventLogs. 

The following dialog box is displayed:

3 Select All Accounts or Specific Receiver / Account, and the Date Range. 

All Accounts The operator can purge the Event Log data for all the 
accounts in the date range selected.

Specific Receiver 
/ Account  

Type the Receiver number and Account number in the 
text boxes provided.

4 Click Purge EventLog. All the Event Log data for the selected period, for the 
selected accounts is purged.

5 Click Close to close the dialog box.

Step Action

1 In the Compass Shell screen menu, click Tools> Rename Receiver Group. 

The following screen is displayed:
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Exporting and Importing Accounts
4.9  Exporting and Importing Accounts
You can copy a single account from one computer to another. This facility is especially useful for 
technicians at a job site, working with laptops. 

• When exporting an account, copy the account from your current Compass database to a drive 
on a network or to a floppy disk.

• When importing an account, copy the account from a network drive or a floppy disk to your 
current Compass database.

Exporting an Account
To export an account, perform the following steps:

2 Type the Old Receiver name and the New Receiver name in the appropriate 
text boxes.

3 Click the Check Conflicts button to ensure that the change does not duplicate 
a Receiver Group / Account number information. 

4 If there are no conflicts, click Rename Receiver to change the Receiver 
Group name.

5 If there are conflicts, reassign the accounts that do not conflict with the new 
Receiver Name by selecting the Rename Accounts Not In Conflict box.

6 Click Exit to return to the Customer screen.

Step Action

1 Select an account from the Customer grid in the Compass Shell screen.

2 From the menu bar, select Tools>Export Account. 

A window titled “Save Exported Account As” is displayed.

3 Type a file name. Ensure that the name has an extension of “.wdl”.

4 Select the drive to which the file must be copied. 

5 Select the directory on that drive to which the file must be copied.
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Customizing the Customer Account Screen
Importing an Account
To import an account, perform the following steps:

4.10  Customizing the Customer Account Screen
You can customize the way the Customer grid displays accounts.

Making Changes to the Layout
To change the column width, click the right edge of the column and drag to the left to narrow it, or to 
the right to widen it. 

To change the column position, click a column heading and drag it to the column position you want. 
For example, to move Zip Code after Panel Name, click Zip Code and drag the mouse to the required 
position. 

The two red arrow heads indicate the new position of the column.

6 Click Ok.

Step Action

1 Select an account from the Customer grid.

2 On the Customer Account screen, select Import Account under Tools on the 
main menu bar.

A window titled “Select File to Import an Account” is displayed.

3 Select the drive where the file to be copied is located.

4 Select the directory on that drive where the file to be copied is located.

5 Select the file with the account to be copied.

6 Click Ok.

The imported account appears in the Customer grid in the Compass Shell 
screen.
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Viewing Unattended Jobs
Saving the Changes
To save the layout and the Search Options, perform the following steps:

4.11  Viewing Unattended Jobs
Click  in the customer screen to view the status of all the scheduled jobs.

On clicking Unattended Jobs, the Viewer screen is displayed:

Step Action

1 Click Options on the Customer screen menu bar.

2 Click Save & Use Layout. You will see it selected the next time you go to the 
Options Menu. Every time the option is selected, it toggles on or off.

You can save your screen layout when you exit the Downloader application by 
keeping the option checked.

3
To restore the original customer grid layout, click the Restore button  
located in the upper-left corner of the grid.
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Defaulting Panel Information
Figure 5-4 Viewer [Customers]

You can see the status of all the assigned tasks in the displayed table. It also shows the details like 
start date and time, the end date and time, the panel name, and number of retries (Retry Count). The 
search options allow you to search for details of particular revisions or panels. 

The third search option is based on the sort option that you selected. In the Viewer [Customers] 
screen, the sorting is done based on Account number. Hence you have a search option “Acct # 
begins with”.

4.12  Defaulting Panel Information
This option allows you to replace the current panel information with default values.

To load the panel information with default values, perform the following steps:

REFERENCE- INTERNAL

For more information on Unattended jobs and other features refer to 7.1 
Unattended Operation.

Step Action
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Modifying Panel Information
4.13  Modifying Panel Information
This option allows you to edit the current panel information. 

To modify the panel information, perform the following steps:

4.14  Scheduling Jobs
You can use this option to schedule the unattended communication tasks.

To schedule the jobs, perform the following steps:

1 Click Default at the bottom of the customer screen. A message box is 
displayed.

 

2 Click OK to update the panel information with the default values or click 
Cancel to cancel the operation.

Step Action

1 In the customer screen, highlight the account whose panel information is to be 
modified.

2 Click Modify at the bottom of the customer screen.

3 The corresponding panel application screen (16 bit or 32 bit application) for 
the panel is displayed.

TIP

Alternatively, you can double-click the selected customer row to display the 
corresponding panel application screen.

Step Action

1 Select the customer row from the customer grid.

2 Click the Schedule button located in the Panels options area of                        
the screen.

3 The corresponding Ademco, ADT, Apex or FBII scheduler screen is displayed, 
which is used to schedule the jobs.

REFERENCE- INTERNAL

For more information, refer  Scheduling Ademco Unattended Jobs,  
Scheduling FBII Unattended Jobs , and  Scheduling Apex Unattended Jobs 
.
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Viewing Event Logs
4.15  Viewing Event Logs
You can use this option to view the log form which displays the previously uploaded event logs for the 
panel. The event log form displays the list of all the commands that have been previously executed in 
the interactive mode.

To view the event logs, perform the following steps:

Step Action

1 Select the customer row from the customer grid.

2 Click the View Log on the screen. 

If there are no records, the following message box is displayed.

Or

If there are event log records, the View Event Log screen is displayed.

TIP

Alternatively, enter the interactive communication modules for the specific 
accounts and click Event Log button in the bottom tool bar, to view the event 
logs.
38 Compass 2.0 User Guide  R2.0
Honeywell 07/10



Alarm Control Programming
5.  Control Panel Information

5.1  Alarm Control Programming
Control panels belonging to Ademco, FBII, and Apex protocols are available for use with the Compass 
commserver. Most of the panels that legacy Compass 16-bit supports, are supported in Compass 2.0.

To access the Alarm Control Programming (Panel Edit) screens: 

• Double-click the highlighted customer account row in the Customer screen of the Downloader.

• Alternatively, highlight the customer account row and click Modify in Panel Options.

Figure 6-1 Compass 2.0 [Customers]

Based on the panel supported, the panel application for Compass 16, or the panel application for 
Compass 2.0 is displayed.

REFERENCE- INTERNAL

For more information on panels supported by the different versions of 
Compass, refer to 1.4 Viewing a List of Panels Supported by Compass 2.0. 
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Panel Application for Compass 16
5.2  Panel Application for Compass 16

Overview
A 16-bit panel screen, in general, includes the following layout:

Figure 6-2 Control Panel

At the top of the screen is the title bar. It identifies the control panel type and revision, and the 
receiver/account number of the customer you selected. Under this is the menu bar. The options in the 
menu bar are not control panel-specific as they are Downloader operations.

Menu Bar options

File 

Option Allows you to…

Save Save the alarm control settings.

Print Setup Select and set up the printer. 

Print Programming form Print a programming form that reflects the account’s 
current Edit data.

Exit Exit the application.
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Panel Application for Compass 16
Communications
Clicking Communications in the Panel menu bar takes you to the Compass Communications screen. It 
allows you to upload or download information to the panel, providing the ability to arm, disarm, retrieve 
status, bypass zones, and send messages.

View
The View modes enable you to see different versions of a control panel’s E2 data. You can view the 
values saved in the Downloader, values uploaded from the control, default values, or an unsaved 
current Edit value. The screen in view is indicated in the upper-right corner of the title bar.

Search 
This option allows you to search for a specific programming option by field number or name. To do this, 
select Search from the Panel Edit screen. The following screen is displayed:

ATTENTION

The availability of these options is dependent on the panel being connected to, 
and the panel programming options.

Option Allows you to…

Current Edit View the changes just made (not saved yet) to the control 
programming.

Upload View the data last uploaded from the alarm control.

Saved View the previously saved data.

Defaults View the programming defaults for a control panel. (Some, like 
the Lynx family panels, have multiple default options available.)
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Panel Application for Compass 16
Figure 6-3 Panel Feature Search

To search for a particular option, perform the following steps:

Features 
This menu displays the same options as those on the button bar, with the hot key details.

Step Action

1 Type the programming field number or part of the field name that you are 
looking for.

2 Click the Find First button. If you want to go to the field in the programming 
screens, click the Go To button. Compass takes you to the appropriate screen 
and indicates the field with a red arrow.

3 If Find First did not bring you to the option you wanted, press Find Next to go 
to the next option matching the criteria. Use Find Previous to go back to an 
earlier option.

TIP

Double-clicking the programming field also takes you directly to the 
appropriate screen.
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Panel Application for Compass 2.0
Window 
Presents normal Windows features, such as cascading and arranging screens, and displays screens 
currently open.

Help 
Select About to view the version and release date of the Compass Database and of the Panel Edit 
module for the panel you are modifying.

Programming an Alarm Control
From the Downloader customer screen get to the panel screen as explained in the Alarm Control 
Programming overview. The Panel screen varies according to the features of the control panel 
selected.

To program the panel, perform the following steps:

5.3  Panel Application for Compass 2.0
The panel application designed for Compass 2.0 is a new and improved version of the earlier 16-bit 
panel applications. Feedback and comments from users were used for designing the screens. 

As against the functionality-centric navigation of the earlier panels, the new design offers a 
partition-centric navigation, besides a more logical approach to configuration.

Step Action

1 Select the section (Partition, Dialer, Zones) to program from the button bar 
(refer to  Figure 6-2 Control Panel).

2 Type the control panel programming information.

3 When you complete programming, select Close. 

The Save Changes screen is displayed:

4 To save the programming information, click Save. To close without saving, 
click Undo. To return to the Panel Edit screen without saving, select Cancel.
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Panel Application for Compass 2.0
Overview of the panel
The panel application designed for Vista250FBP is taken as an example in this user guide. The design 
of all other panel applications follows similar lines.

The panel application has a left navigation bar and a right pane that shows the corresponding user 
interface controls.

The left navigation bar contains the listing of different configuration groups. Click the required group to 
display the screen in the right pane.

The partition screen is displayed in Figure 6-4. The application enables you to configure all the 
attributes related to a partition on a single page while with the previous panel you had to navigate to 
different tabs to program a single partition.

You can also configure the zones, devices, users, and schedules for that partition without navigating 
outside of the Partition tab.

Figure 6-4 Panel Application for Compass 2.0

Navigation

The left pane is the navigation bar to the different configuration groups. To configure partitions, globals, 
dialer properties and so on, click the relevant tab on the pane. 

Sub-menus under the tabs for the different configurable screens for the particular group facilitate easy 
navigation.

You can configure associated zones, devices, users, and schedules by selecting the configuration 
group under each partition. For example, to configure the zones for partition 1, click the Zones tab 
under Partition 1 in the left navigation bar. The configurations that you select in this tab are applicable 
exclusively to partition 1. 
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Panel Application for Compass 2.0
Figure 6-5 Left Navigation Bar
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Panel Application for Compass 2.0
The Menu bar

Figure 6-6 Menu

Menu Option Purpose

File The File menu offers the following 
submenu options:

• Save – To save changes to 
data.

The toolbar includes the 
shortcut.

• Print Programming Form - 
To launch the Print dialog 
which can be used to Print 
the account’s current 
configuration data

• Exit – To exit the 
application

View You can view the following from the 
View menu:

• The Toolbar below the 
menu bar

• The Status Bar at the 
bottom of the screen

• The Task List on the left 
pane

• The Currently edited data 
(onscreen data)

• The Uploaded data

• The Saved data

• The Default data

Tools The Tools menu offers the following 
sub-menu options:

• Communication

• Search
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Panel Application for Compass 2.0
Communication This option launches the 
communication screen.

Search The Search feature allows you to 
quickly find a feature and its 
configuration details in the 
application. Search from the existing 
list of features by selecting the 
Browse through the features option, 
and select the feature group name 
from the Search In dropdown. To 
search through all the groups at 
once using keywords, select the 
Search option, select ‘All’ in Search 
In, and type the feature in Search 
for. Click Find. The results are 
displayed in the Results pane below. 
To go to the feature, double-click the 
searched feature, or select the 
feature and click Goto. Click Close 
to close the Search dialog box.

Menu Option Purpose
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Panel Application for Compass 2.0
Save Changes Dialog
The Save Changes window is displayed when Compass is closed by clicking the ‘X’ button. Other 
functions can be performed by clicking the following buttons. 

• Save’ - Modified values in PA will be saved and return back to the edit view. 

• ‘Save and Exit’ –Modified values will be saved and exit.

• ‘Undo and Exit’ – Modified values in PA will not be saved and the following message box will 
be popped up.

If you select ‘Yes’, Undo operation will occur and the application will exit.

Help The Help menu launches the 
Compass Help file. You can search 
by Index,

Contents, or search keywords.

It also launches the About box which 
gives the version details of the 
Compass Downloader application.

Menu Option Purpose
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Panel Application for Compass 2.0
If you select ‘No’, the application will come back to the edit view.

Configuration Groups
Following are the configuration groups to be programmed in the panel:

• Partitions

• Globals

• Dialer

• Device

• Users

• Relays

• Zones

• Access

• Schedules

A brief description for each of these groups follows.

Partitions
Partitions allow you to break up a large area into smaller sections. This feature is useful to disarm 
certain areas while leaving other areas armed, or to limit access to certain areas to specific individuals.
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Panel Application for Compass 2.0
Adding and Removing partitions
To add or remove partitions, perform the following steps:

Step Action

1 Click the Partition tab in the left navigation bar.

The different tabs under Partition are displayed.

2 Click +Add Partition to add a new partition. 

3 Click -Remove Partition to remove the last added partition.
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Panel Application for Compass 2.0
Configuring Common Data
Information regarding common lobby, and the description and definition of macro commands is 
common across the partitions. Configure these from the Common Data tab.

Figure 6-7 All Partition Common Data
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Panel Application for Compass 2.0
Configuring Partition Specific Data
Configure the data specific to each partition in the individual partition screen.

Figure 6-8 Partition Specific Data

You have to configure the following for each partition:

Data Allows you to…

General information Specify a description, name, the primary 
and secondary subscriber Ids, and the 
Alpha descriptors. 

System Options Specify system options including the 
Entry and Exit delays allowed by the 
system, the display characteristics, the 
general rules for arm, disarm, and 
bypass, and enabling of certain 
specialized features and rules. 
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Macro Key Assignment Select Macro Key Assignments from the 
drop-downs. A Macro or Speed Key 
command is a series of keystrokes stored 
in the system memory and activated 
when a programmed lettered key is 
pressed. Each Speed Key command can 
include 32 keystrokes. Generally four 
macro commands (A, B, C, and D) are 
supported. However, this varies from 
panel to panel.

Typical macro functions include:

• Arming sequences that involve first 
bypassing certain zones before 
arming

• Seldom-used but repeatable 
sequences

• Relay activation sequences

Lettered keys A, B, C, and D are 
assigned a specific macro definition by 
entering a Speed Key number.

Sounder Options Indicate the sound settings for the bells 
and auxiliary relay.

Communication Specify the communication delays and 
swing suppression count.

Dialer Reports Indicate the zones for which the reports 
are to be sent.
R2.0 Compass 2.0 User Guide 53
07/10 Honeywell



Panel Application for Compass 2.0
Dialer
The settings for connection to panel, and communication are configured in the dialer. This includes the 
downloader phone numbers, panel phone numbers, communication channel details, and devices 
information.

Figure 6-9 Dialer Features

Options Allows you to…

Dialer Features Configure the Receiver-Account#, CSID, 
PABX, ring count, primary and secondary 
phone numbers dialing methods, 
download information, and max dialer 
retries.

Tx Format Configure the transmission format and 
speed, select reports, and select system 
non-alarm codes.
54 Compass 2.0 User Guide  R2.0
Honeywell 07/10



Panel Application for Compass 2.0
Communications Configure dynamic signaling options, 
reporting intervals, initiating time and day, 
and select zone type reporting restore.
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Report Codes Enable and disable the alarm, troubles, 
and bypasses for a set of zones. The 
options configured for a group of zones in 
the top pane are displayed for individual 
zones in the bottom pane. In the bottom 
pane only the report code (Rpt) column is 
editable. The report code field takes 
values from A-F and 1-9.

 TIP: The Find Zones feature helps you find a zone quickly. Type the zone 
number that you are looking for, and press Enter. The row corresponding to the zone 
number is highlighted.

Reporting Options Configure the pager details and the 
reports that go out from specified 
partitions to specified pager numbers. 
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Device
The details of all devices connected to the panel are configured here. 

Figure 6-10 Device Configuration

Globals
Set the global System options, RF Options, Event Log options, Fire options, Sounder options and 
Remote access options in this screen.
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Figure 6-11 Globals - System Options

The settings you select here are common across the panel. 

Options Allows you to…

System Options Set some common system options.

RF Options Set RF options. 

Use an RF button-type transmitter to 
provide entry or exit for several doors. 
One button controls one door. A button 
can be used to provide access or egress 
due to a panic or duress condition. An RF 
transmitter is used with a remote switch to 
provide exit in case of a fire alarm.
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Event Log Options Set Event log options – options for LRR, 
time format, and printer.

Fire Options Set fire options – bypass fire zones, 
options for waterflow supervisory zones, 
fire display lock, and so on.
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Sounder Options Specify the sounder options for different 
situations.

Remote Access Options Set remote access options. The Read 
Only Panel Remote Access Enables 
gives you an indication of the commands 
that you are allowed to execute through 
the communication server. 
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Users
In this screen you can record details of the panel users such as user name, code, access group, and 
partitions that the user can access. 

 ATTENTION: The enabling and disabling of the commands are done at the 
panel end. The user can only view the status here.
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Figure 6-12 Users

Zones
Zones, in the context of an alarm system, are individual sensors. If the alarm gets triggered, the 
system records the zones that were tripped, allowing you to know the exact point of action. Zones also 
help the monitoring station to know whether they should call the police or fire department upon an 
alarm. Each zone must be assigned to a partition.

Zone Configuration
In this interface you can configure all details related to each zone, such as the response type, report 
codes, input type, partition, loop and serial numbers, associated devices, relays, access points, 
bypasses, tamper options, vent options, faults and so on.
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Figure 6-13 Zone Configuration

Click Activate Reporting Zones to initiate zone reporting.

Cross-Zoning Pairs
The Cross-Zoning feature allows an alarm condition on any of the zones only when a combination of 
two zones is faulted within a specified period of each other. This prevents momentary faults from one 
of the zones causing an alarm condition. You can select a maximum of four pairs of cross-zones.

For example, for Vista250FBP Panel, you need to select a maximum of four pairs of cross-zones as 
shown in the following figure:

Figure 6-14 Cross-Zoning pairs
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Schedule
Under Schedule, you can configure the different time windows and schedules (weekly, holiday, 
temporary, limitation of access, and check-in), time-driven events, output device timers, and reports.

A time window is a period of time during which an event is permitted, or a specific time used to trigger 
an event.

Time windows are summarized as follows:

• Scheduled events are based on time windows, which are periods of time during which an event 
may take place.

• A time window is defined by a “Start” time and a “Stop” time.

The windows are shared by all partitions, and are used when programming time-driven events.

TIP

Temporary schedule and Weekly Schedule can be configured through the 
partition screen also.

Parameter Allows you to…

Time Windows Configure the time windows.

TIP: There are two methods of configuring the time windows. One is through the 
time controls, where you specify the Start time and End time. The other newly 
introduced feature allows you to set your start and end times by clicking your mouse 
in the graphical control chart and dragging it to specify the time. 

Weekly Schedules Configure the delay, disarm, and warning 
periods, and auto arm times for each 
partition. 

Each schedule for Open/close scheduling 
consists of one time window for openings 
and one time window for closings.

These time windows are represented 
graphically in the graphic control.
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Holiday Schedules Configure the holiday schedules for the 
partitions here.

Temporary Schedules Configure the temporary open and close 
start and end times for any partition, for 
any day. 
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Limitation of Access Schedules Configure the times at which certain 
windows are not accessible to certain 
groups.

Time Driven Events Configure time driven events here.

Time-Driven Events are time-based 
triggers for certain actions. Note that 
Time-Driven Events are optional and are 
not required to operate the system. 
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Output Device Timer Configure the on and off times for the 
different days for all the output devices 
used with the panel.

Check-in Schedules Schedule check-in.

Example: If a quarterly check-in is 
scheduled, select the day of the month, 
and check-in time for each quarter.
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Relay
Relays, used in conjunction with the control panel, are programmable switches that can be used for 
performing many different functions. They can be used for turning the lights ON and OFF, control 
sounders and doors, or for status indications. In this system, each device must be programmed as to 
how to act (ACTION), when to activate (START), and when to deactivate (STOP). 

This control supports up to eight 4204 or sixteen 4204CF Relay Modules. Each 4204 Module provides 
four relays with Form C (normally-open and normally-closed) contacts. This means you can program 
up to thirty-two relays to activate and de-activate, as required. Each 4204CF Module adds two 

Scheduling Reports Select the reports that you want to 
activate.
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additional style-Y supervised bell outputs to the system. If 4204CF Modules are used, only relays 1 
and 3 on each module can be programmed. The other two relays (2 and 4) on each module are used 
for supervision purposes.

Configure the following under Relay:

Options Allows you to…

Relay Timeout options Configure the long and short timeout for 
each of the access control relays. The 
relay timeout function is an alarm feature 
that disables the relay after a specified 
time.

Relay Zone List Assign a zone to a zone list. Select the 
zone, and the list that you would like to 
assign it to, and click Associate. The 
association is displayed in the grid. To 
dissociate, click DisAssociate.
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Output devices Configure output relay devices. 

Voice Description Configure the descriptions for panels 
supporting voice alarms. The ‘Old Word’ 
columns are non-editable, and they take 
the existing value of the descriptions. 
Change the ‘New Word’ columns to the 
most recent description.
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Access
The configuration of the access groups, access points, and card data is done in this section of the 
panel application.

Parameter Allows you to…

Access Group Define the access group configuration.

An access group provides a means of defining 
which access points can be used, when, and by 
whom. Any, all, or no access points may be 
assigned to an access group. Schedules, when 
assigned to an access group, define the times at 
which the access points will allow access. The 
access group can be assigned to a particular 
cardholder, thereby defining who will be granted 
access through specified access points during 
specified periods of time.

A special 'executive privilege' attribute allows 
access anywhere, anytime to the cardholder 
assigned to the access group.
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Access Point Configure access points.

An access point is a particular point of passage 
over which we have control. There are a number of 
components that can be associated with the 
access point, which helps to reinforce the desired 
level of security. 

Event Action Configure actions corresponding to certain events.
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Change and Compare 
The Change and Compare screen has options to view changes made to Saved, Default, Uploaded 
and CurrentEdit data and at the same time compare data between any two E2 images.

Change
Change allows you to see the changes you have made to a view after the last ‘Save’ operation. To see 
the changes made to any view select the View from the Menu bar. You may select Current Edit, 
Saved, Default, or Uploaded View. The grid displays the changes that were made to the particular view 
after the last ‘Save’ operation. You can select to overwrite the new value with the old value of the 
features by selecting the appropriate checkbox, or for all features at once by selecting Select All. Then 
click Merge Selected to overwrite the values.

The number of changes to the view is displayed at the bottom of the screen. 

Note that the Compare and With fields are disabled when the Change option is selected.

Card Data Configure the access card. 

The details of privileges, access group to which the 
card belongs, event types and actions, number of 
usages, and the expiration date recorded in this 
screen. 

Click Add Card and enter Enrollment number to 
begin access configuration.
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Figure 6-15 Change

Compare 
Use the Compare option to compare your Saved, Default, Uploaded or Current Edit values for each 
feature with any of the values in the other three E2 views. For example, the Saved value of a feature 
can be compared with the Default, Uploaded or Current Edit value for the feature.

To compare, select the values to be compared from the drop-downs for Compare and With. Click Go. 
The features and the comparison of values are displayed in the grid. 

The number of differences between the compared values is displayed at the bottom of the screen.

You can overwrite the values for each feature by selecting the Overwrite… option in the last column of 
the grid. To replace all the values with the modified value, select Select All above the grid. Click 
Merge Selected to replace the values.
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Figure 6-16 Compare 

History
The ShowLog screen shows the history of the changed data. The previous and changed values of the 
feature are displayed. You can specify the date range between which you want the history data. The 
data in the grid can also be sorted based on the date/ feature description / Operator name. Click 
Refresh Data to refresh the screen.
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Figure 6-17 History

5.4  Using Templates
Templates are used to create “master” files for control panel programming data to speed up 
programming of a new account. A template gives you a very quick and easy way to add a customer’s 
alarm control programming information.

To access the available Template screen, click  at the top of the Compass Shell screen. The 
following screen is displayed:
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Figure 6-18 Available Templates

Creating New Templates 
To create a new template, click Templates at the top of the Customer Information screen, perform the 
following steps:

Step Action

1 Click Add in the available templates window (refer to  Figure 6-18 Available 
Templates ). 

The screen displayed allows you to type the control panel type, the revision, 
and a name for this template.

2 Click Ok to save, or Cancel to close without saving.
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Modifying Templates 
To modify an existing template, perform the following steps:

Deleting Templates 
Use the Delete button on the available templates window (refer to  Figure 6-18 Available Templates) to 
delete an existing template. Confirm deletion when prompted.

Setting Up an Existing Customer Template
To use another customer’s account data as a template, perform the following steps:

3 To edit the data you have saved, click Edit to the top-left of the Template 
Name column (refer to  Figure 6-18 Available Templates). 

The Panel Template Data dialog box opens again and allows you to make 
changes to the Revision and Template Name. 

 ATTENTION: The Panel selection cannot be changed using Edit.

Step Action

1 Click the Templates icon at the top of the Customer Information screen.

2 Select the template from the Templates list.

3 Click Modify. 

The alarm control Panel Edit screen opens, where you can program the 
template information. 

4 When you have completed setting up the template, select Close and then 
Save to save the information.

Step Action

1 Create a new template as detailed in the section  Creating New Templates .

2 Click Customer Data. 

The Select Customer Data.. dialog box is displayed. 

3 Type the Receiver Number and the Account Number of the customer 
account to be copied.
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Using a Template to Create a New Account 
Templates speed up the process of programming a control panel. 

To use a template to program a control panel, perform the following steps:

5.5  Copying an Account
The Copy command can be used in place of Templates to copy programming information quickly from 
one control to another. 

To copy an account, perform the following steps:

4 Click Ok to copy the customer details to the template. Confirm the operation 
when prompted.

Step Action

1 Create a new account or highlight on the Customer Information screen the 
account that the template is to be applied to.

2

Click , at the bottom of the Customer screen. 

The following screen is displayed:

 

3 Select the template to be applied to the account.

4 Click OK. The GUISubscriber Tools dialog box is displayed.

5 Click Yes to update the Panel data from the selected template.
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Step Action

1

Click  at the bottom of the Customer screen. 

The following dialog box is displayed.

2 Type the Receiver and Account number of the control panel from which the 
programming information is to be copied.

3 Type the receiver and account number of the panel to be copied. 

4 Selecting Create New Panel creates a new panel with the panel type 
corresponding to the destination account and copies all the data to the new 
account.

ATTENTION

An account can be copied only to another account that uses the same control 
panel type and revision.
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6.  Interactive Communications

6.1  On-Line Communications
The redesigned Compass 2.0 Communication Server (Commserver) supports a set of panels with the 
Ademco, FBII, and Apex protocols. You can continue to use the Compass 16 communication server for 
the unsupported panels.

The following chapter guides you through Interactive Communications for Ademco, FBII, and Apex 
control panels.

6.2  Ademco 

Launching the Ademco Commserver
To launch Interactive Communications with an Ademco panel, perform the following steps:

Step Action

1 From the Customer Account Screen, customer table, select an Ademco 
customer. 

2 Click Modify in the Panel Options toolbar. 

The Panel Programming screen is displayed.
R2.0 Compass 2.0 User Guide 81
07/10 Honeywell



Ademco 
Panel for Compass 16

Panel for Compass 2.0
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3 Select Communications from the “Tools” option in the menu bar of the Panel 
Programming screen. You can alternatively click the Communication Toolbar 
button as high-lighted below - 

The Compass Communications screen for the selected account is displayed. 

Figure 7-1 Compass Communication - Ademco Interactive UI
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4 Click File> Communication Settings.

The Communication Settings screen is displayed.

5 Ademco is selected as the default company as you have selected a customer 
who uses an Ademco panel. 

After the modem is configured, click Apply. Click OK to close the Modem 
dialog box.

 REFERENCE– INTERNAL: For more information on modem setup see 
2.2 Setting up the Modem.

6 Click Connect on the Communications screen.

The Communications dialog box is displayed:
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Figure 7-2 Communications - Connection Details

Configure the connection details here.

7 Select the Comm Port from the drop-down.

8 In the Initiate From box, select the origin of the call. It might be PC or Panel. 

If your control is directly connected to your computer’s serial port, (if supported 
by the control) select Direct. In Direct, the PC and Panel are connected by a 
RS232 cable.

On some panels, a Telco option is also available. The setup in Telco is very 
similar to Direct except that there are telephone handsets placed at both ends 
that enable voice communication.

 ATTENTION: The Direct and Telco modes are only for Interactive 
Communications. They are not applicable to Unattended Communications.

9 Select Answering Machine Defeat if there is an answering machine at the 
premises. The ring count in the panel should be programmed for 15.

 REFERENCE– INTERNAL: For more information, refer to 

 Configuring for Answering Machine Defeat.
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10 Type the panel phone number if it is not already entered in the Customer 
Detail screen. 

To save the phone number, select Save to the right of the control panel phone 
number. This is the number used for calling this particular panel, and is 
displayed on both the Customer Detail and Communications screens.

 TIP: If you need to change the number, type the new number and select 
Save again. The old number is overwritten. If you want to temporarily use 
another number, type it, and after the session, select Undo. You are asked if 
you want to restore the earlier number. Select OK.

11 To use the TCP/IP connection, select Enable TCP/IP.  

The following window is displayed:

12 Select TCP/IP port from the drop-down.

Select the required option for Connection Mode - Direct Wire or ECP, based 
on whether you want to connect to the Panel through Direct Wire or through 
ECP.

If you want to communicate over an Intranet, select the option Private LAN 
and select  Central Station 1 IP and/or Central Station 2 IP from a list of the 
7810iR Device names that you have configured through File -> Device and 
Computer Names/ IP Addresses.

 REFERENCE– INTERNAL:  For more information, refer to 2.4 
Mapping Devices to IP.
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13 If you want to communicate with the panel over Internet (through AlarmNet-i 
Control Server), select the option AlarmNet-i. 

 REFERENCE– INTERNAL:  For information on configuring the 
Alarmnet-i URL, refer to 2.2 Setting up the Modem.

14 Type the Network Device MAC Addr (IP communication Device MAC 
address) if it is not already entered in the Customer Detail screen. 

To save the MAC address, select Save. This is the address used for 
connecting to this particular panel through TCP/IP, and is displayed on both 
the Customer Detail and Communications screens.

 TIP: If you need to change the address, type the new address and 
select Save again. The old address is overwritten. If you want to temporarily 
use another address, type it, and after the session, select Undo. You are 
asked if you want to restore the earlier address. Select OK.

15 Some panels, like the Lynx family panels, support a Flexible Callback Option. 
The Download phone number that you type in the dialer screen of the panel 
(see figure below) is used as the basis for the callback number. 

The figure below shows the Flexible Callback Phone Number option. This 
option allows you to change the last three digits of the configured callback 
number.
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16 Select Use Account CSID if the panel you want to communicate with has 
already been downloaded. Otherwise, select First Time Communication and 
select Acct # in Panel if the account number is available in the panel.

If the panel is yet unprogrammed, select First Time Communication without 
selecting Acct # in the panel.

17 Click Connect.

18 The PC calls the panel if Initiate From PC was selected. 

If Callback is enabled, the modem disconnects and waits for the panel to call 
back. 

If Initiate from Panel was selected, the Installer Code + [#] + [1] must be 
entered at the panel keypad, which causes the panel to call the PC. The 
progress of the connection is displayed at the bottom of the screen.

After the initial exchange and verification of the CSID and the subscriber 
account number, a Status screen is displayed. This screen displays the 
current status of the panel: 

ATTENTION

If you select First Time Communication:  The panel must be programmed for 
a Ring Detect greater than zero, and a Download Callback Number. If 
Callback is disabled at the panel, you must also enable Download Without 
Callback in the Downloader.

If you select USE ACCOUNT CSID:

• The panel must have a Ring Detect Count greater than 
zero. 

• If the panel has Callback enabled, a Download Callback 
Number must also be programmed. 

• If Callback is disabled at the panel, you must enable 
Download Without Callback in the Downloader. 

• The subscriber’s account number must be programmed into 
the panel and must match what is in the Downloader. 

If any of these items do not match, the panel does not get on-line with the 
Downloader.
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Available Options in Ademco
There are various settings you can configure from the Options menu in the Communications Menu 
bar.

Figure 7-3 Ademco Communication Options

ATTENTION

In Unattended Communications, the options are accessible from the Settings 
button of the Setup window. For more information, refer to step 3 of  Setting up 
Ademco Unattended Mode .

Option Description

Download Warning Issues warning, if you attempt to download without 
first performing an upload during the current 
communication session. 

You can still perform the download without performing 
the upload.

Caller ID Displays the Caller’s information on the Customer 
Detail screen during the connection.

Answer on Two Rings Answers an incoming call on the second ring. This is 
particularly useful while using the Caller ID feature. 

The Caller ID signal is sent between the first and 
second rings.

Auto Answer Machine Defect If this option is selected, the answering machine is 
automatically defeated irrespective of whether manual 
defeat is selected or not.

Telco on all Panels All connections are made through the Telco mode 
irrespective of selection in the communication window.

Alternate Protocol Helps to maintain the connection when disconnect 
problems occur during upload/download.

Beep on Connect Causes the computer to beep when a connection to 
the panel is established.

Busy Detect Enables the X4 option of the modem, which reports if 
the phone is busy.
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Log reports available in Ademco
Event Logs, or the list of all events with the time and date are recorded in Ademco, as in all the other 
protocols. However, in some high-end panels of Ademco, in addition to Event Logs, other options like 
ECP (Expander Console Protocol) reports, Fire Test reports, and Unsolicited alarm reports. They are 
explained as follows:

• ECP Reports: Lists all the addressable devices connected to the system (keypads, voice 
module, and other devices).

• Fire Test Reports: Views the results of the Fire Walk Tests that have been logged onto the 
panel.

• Unsolicited Alarms: Lists all alarms that have occurred when on-line.

Configuring for Answering Machine Defeat
Sometimes the Downloader might have to initiate calls to sites that have an answering machine. In 
such cases, you must ensure that the call is picked by the panel and not by the answering machine. 

To do that, perform the following actions:

1. Enable the modem speaker in the Downloader Communications screen so that you can hear the 
phone ringing at the site.

2. Enable Answering Machine Defeat in the Connect screen of the Downloader or in the Dialer 
section of the panel programming screen.

3. Program the panel’s Ring Detect Count for 15 rings.

To initiate connection to a site with an answering machine, perform the following steps:

REFERENCE- INTERNAL

For more information on Event logs, refer to 6.5 Event Logs and  Viewing 
Event Log (Ademco) ( in section 9.3.).

Step Action

1 Select Answering Machine Defeat on the Downloader Communications 
screen.

A prompt appears asking you to “Press Escape or Click OK after first Ring”. 
Press the Escape key or click OK.

2 The first call is disconnected immediately and a second call is made. The 
panel picks up on the first or second ring of the second call, ‘defeating’ the 
answering machine. If the panel is programmed for Callback Required, it 
hangs up and calls the PC.

3 The PC takes the call and a connection is established.
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6.3  FBII

Launching the FBII Commserver
To launch Interactive Communications with an FBII panel, perform the following steps:

Step Action

1 Go to the Customer Account Screen and select the FBII customer from the 
grid. 

2 Click Modify in the Panel Options toolbar. 

The Panel Programming screen for the selected panel is displayed.

3 Select Communications! from the menu bar of the Panel Programming 
screen.

The Compass Communication screen is displayed.
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Figure 7-4 Compass Communication - FBII Interactive UI

4 Click Connect. The Communications dialog box is displayed. 
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Setting up the Modem for FBII panels
To configure the modem for FBII panels, perform the following steps:

5 In the Initiate From box, select the origin of the call. It could be PC or Telco.

If your control is directly connected to your computer’s serial port, select 
Telco. In Telco, the PC and Panel are connected by an RS232 cable. 
Telephone handsets at both ends enable voice communication.

Compass initiates communications with the panel. When on-line, you can 
modify the existing account programming information and perform a number of 
online commands.

 ATTENTION: The Telco mode is only for Interactive Communications. 
It is not applicable to Unattended Communications.

Step Action

1 Click File> Communication Setup in the menu bar. 

The following screen is displayed:

 REFERENCE– INTERNAL: For more information on modem setup, 
see 2.2 Setting up the Modem.
R2.0 Compass 2.0 User Guide 93
07/10 Honeywell



FBII
Available Options in FBII
Click Options in the menu bar to view the different options available in FBII panels.

Figure 7-5 FBII Communication Options

2 FBII is selected as the default company. You can select a modem from the 
available list or click Add under Custom Modems, to configure a new modem 
that is not in the list. 

3 Select the COM Port. 

4 Select Touch Tone and Speaker on, if required. Adjust Volume. 

5 Type the Dial Out Prefix.

6 Configure the FBII F7702 Interface. 

 REFERENCE– INTERNAL: For details on configuring the Interface, 
refer to  FBII F7702 Interface.

7 Click OK.

Option Description

Show Activity If this option is enabled, the UI shows the progress of communication 
activities like send/receive data. This is applicable only to Compass 
16, and not to Compass 2.0.

Turbo Mode If this option is selected, no status request occurs between 
commands. 

A status request is sent only if there are no pending commands, or if 
the command requires a status command to end.

Auto Initialize Modem This option initializes the modem on connect.

Connect Speed It is the speed at which the connection is made. You can choose 
Normal, Fast, or Super Fast.

Problematic Modem This option is used to help diagnose and bypass modem problems.

The DTR (data terminal ready) line is used to get the modem’s 
attention. Sometimes this line is not well connected to the cable 
running from the PC to the modem. 
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6.4  Apex

Launching the Apex Commserver
To launch Interactive Communications with an Apex panel, perform the following steps:

To check for a bad cable set:

 1 Choose the Toggle DTR On First Command and Drop DTR 3.1 
Seconds options. 

 2 Do a fake Connect Panel Initiated. 

 3 If the Modem Status TR indicator light goes off on the screen 
but not on the modem, the DTR signal is not getting through to 
the modem. 

 4 This can probably be corrected by replacing the modem cable. 
If replacing the cable does not correct the “Unable to put 
modem in command state” problem, select the Alternate 
At/Hangup (Bad Modem Cable) option.

Alternate AT/Hangup This option changes the method used for obtaining get the modem’s 
attention and disconnects the modem by an alternate method.

Set Time On Disconnect You can set time on disconnect Always, Never, or when Prompted.

Step Action

1 Go to the Customer Account Screen and select an Apex customer from the 
customer table.

2 Click Modify in the Panel Options toolbar. 

The Panel Programming screen for the selected panel is displayed.
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3 Select Communications! from the menu bar of the Panel Programming 
screen.

The Compass Communication screen is displayed.

Figure 7-6 Compass Communication - Apex Interactive UI
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4 Click File> Communication Setup in the menu bar. 

The following screen is displayed:

The modem setup is very similar to Ademco. For more information, refer to 2.2 
Setting up the Modem.
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6.5  Event Logs

Event Logs can be viewed either by clicking  at the bottom panel of Compass 
Communications, or through File>View Logs>Event Logs in the menu bar of the same screen. 

The Event Log is displayed as illustrated below.

6 After the modem is set up, click Connect in Compass Communications.

The following screen is displayed:

7 Type the Panel Phone number.

8 Select the Connection Type and Answering Machine Override Digit. 

The PC Access Code is passed internally. Do not type it.

9 Click Connect.
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Figure 7-7 Event Log - Interactive Communication

To obtain the details of the event, select a row and click View Log, or double-click the row. The Event 
Log Response screen is displayed as illustrated below.

Figure 7-8 Event Log Response - Interactive Communication

The details of the selected log recorded are displayed here. You can click 24 hour to see the time in a 
24 hour format. To print the details, click Print.
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7.  Unattended Communications

7.1  Unattended Operation
Unattended Operation allows communication between the Downloader and the control panel even in 
the absence of the operator.

There are three types of Unattended modes available in Compass. They are: Unsolicited Mode, 
Scheduled Mode, and Mixed Mode.

Unsolicited Mode
In the Unsolicited mode, the Server is not informed in advance that a panel is calling in. When a Server 
receives a call from a panel, it must determine what type of panel it is communicating with, and 
perform the appropriate task.

Scheduled Mode
In the scheduled mode, the Server checks for scheduled jobs to be performed on a panel at a certain 
time. At the scheduled time, the Server connects and performs the tasks scheduled by the operator for 
the panel. 

In this case, the PC initiates the call or calls the panel, disconnects, and waits for a callback.

Mixed Mode 
In the mixed mode, both Unsolicited and Scheduled modes are activated. The Server operates in the 
Unsolicited and Scheduled modes simultaneously. It executes scheduled jobs at their pre-defined 
times; and, when not busy, answers unsolicited calls. This is the default mode and recommended 
mode of Unattended operation.

7.2  Assigning Receiver Groups
You can add, edit, or delete a mapping of Receiver Group to Primary Phone number using the 
Receiver Group Assignment function. 

You may assign duplicate account numbers to accounts programmed to report to different central 
station primary phone numbers. When duplicate account numbers are used during uploading, the 
Receiver Group Assignment option prevents one account from overwriting another that has the same 
account number.

When a control panel using the primary telephone number that is associated with a Receiver Group 
calls for uploading, it is automatically connected to the corresponding Receiver Group. 

To assign receiver groups to phone numbers, perform the following steps:

ATTENTION

‘Unattended Mode’ in Compass 16 is renamed as ‘Scheduled Mode’ in 
Compass 2.0. We have used ‘Unattended’ and ‘Scheduled’ interchangeably in 
this user guide.

REFERENCE- INTERNAL

For more information on how the scheduled mode of operation works, refer to  
Working of the Scheduled Mode .
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Step Action

1 On the Customer screen menu of the Downloader, select File > Receiver 
Group / CS Phone #.

2 Click Add in the Receiver Group Options in the bottom toolbar of the screen. 

3 Type the Receiver Group details (It takes a maximum of six characters or 
numbers) and the corresponding primary phone number.

4 Click Ok. (When the screen is in Add Mode, the Add button is changed to Ok 
button)

5 Enter a different Receiver Group for each central station primary phone 
number that you use.

ATTENTION

If the Downloader does not have a corresponding Receiver Group for a 
primary phone number, when it receives an unsolicited call from a control 
panel for uploading, the Receiver Group displayed for that phone number 
appears as a series of six question marks (??????).
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7.3  Viewing Scheduled Jobs
To view scheduled jobs, perform the following steps:

Step Action

1
Click  in the top left of the Customer Information screen. 

The following screen is displayed:

2 The Viewer displays the Unattended Job Status, the Start Date and the End 
Date.
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3 The drop-down list shows the jobs in various categories. 

Choose the type of Unattended Jobs you want to view based on the following 
description: 

Category Description

Unsolicited Accounts that were created/updated through an 
unsolicited call from a panel.

All Scheduled 
Jobs

All scheduled jobs, regardless of status.

Scheduled Jobs 
-Dialup

All scheduled jobs for dialup connection.

Scheduled Jobs 
-TCP/IP

All scheduled jobs for TCP/IP connection.

Pending Jobs Scheduled jobs for the unattended server that are not yet 
executed.

Finished Any job (unsolicited or scheduled) that is done.

Expired / Failed Scheduled jobs that did not finish in the required time 
frame/ jobs that were not completed. 

4 After choosing one of the job status options and the date information, click 
Search on the upper right of the screen to complete the selection.

The scheduled jobs and their status are displayed in a grid as illustrated below:
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Viewing the Commands and Activity Log Information
For information on the status of the Unattended tasks and commands, click Information in the Panel 
Options of the Unattended tasks Viewer.

The Unattended Batch Commands screen is displayed.

Figure 8-1 Unattended Batch Commands - Commands

Select Commands to see the list of jobs scheduled for the selected batch (row). Any information 
related to the command is displayed in the Message box.

Select Activity Log to display the Activity Log for the selected job. The commands that have not been 
executed are indicated with an “*”.
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Figure 8-2 Unattended Batch Commands - Activity log

Opening the Scheduler
Click Schedule under Panel Options of the Viewer screen. This option lets you open the scheduler 
and select more commands for scheduling. 

Viewing Customer Account Details
Click Detail under Customer Options of the Viewer screen to obtain the details of the customer 
account. The screen is not editable, but you can print it.

Figure 8-3 View Customer Detail
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Deleting Unattended Jobs 
To delete unattended jobs:

Step Action

1 From the list of unattended jobs displayed in the Viewer grid, select the one to 
be deleted. 

2 Click Delete in Customer Options.

The Delete Unattended Log dialog box is displayed with the option to delete 
only the Current job, or all the jobs.

3 Select the appropriate option.

3 Click Ok.

TIP

After deleting an Unattended job, click Search to refresh the screen.
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7.4  Using Unattended Mode

Working of the Scheduled Mode 
The Scheduled Mode works for Ademco, FBII, and Apex protocols as follows:

Starting the Unattended Server 
To start the Unattended Server, perform the following steps:

Step Action

1 The Server checks the unattended queue for jobs to be performed in the 
current time frame. 

For example, jobs can be scheduled to occur during specific time windows, 
such as between 10 AM today and 3 PM tomorrow. An attempt to connect to 
the panel is made only during the specified time range.

2 The server picks the next job to be performed in the time period and attempts 
to connect to the panel.

3 If the connection to the panel fails, another attempt is made 5 minutes from the 
current time, then the next at 15 minutes after that, and the final attempt at 30 
minutes after that.

4 After a successful connection is made to the panel, the Server performs the 
scheduled tasks. 

ATTENTION

If you schedule a second job for the same account, the new job replaces the 
original one and only the new job appears in the queue.

Step Action

1

To start the Unattended Server, click  on the Downloader Shell 
screen toolbar.

The Launch Unattended Server dialog box is displayed.
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2 Select between Compass 16 and Compass 2.0, based on the panel being 
used. 

 ATTENTION: Compass 2.0 may fail to handle the calls coming from 
unsupported panels. In case of unsolicited mode, use separate phone lines for 
Compass 16 and Compass 2.0.

 TIP: To see the list of panels supported by Compass 2.0 and panels 
supported only by Compass 16, click Help of the Launch Unattended Server 
dialog.

3 Click OK. 

The Scheduler Activities Viewer screen is displayed: 

4 Select the Server Type and the Port Name from the drop-downs at the top of 
the screen. 

 

5 Follow the steps for individual Server types as detailed in the following 
sections.
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7.5  Ademco Unattended Communications

Setting up Ademco Unattended Mode 
To set up Ademco Unattended Mode, perform the following steps:

Step Action

1 Follow the steps for starting the unattended server as detailed in  Starting the 
Unattended Server . 

2 Select the Server Type as Ademco and select the corresponding Port Name.

3 Click Setup. 

The following screen is displayed: 
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4 Configure the settings as detailed below:

Setting Description

Server mode Select the server you want to activate– 
Unattended or Unsolicited. Selecting both 
gives you the Mixed mode.

Auto Save Selecting this option enables the 
unattended server to save all the uploaded 
data from the panel automatically to the 
database. You need not save it from panel 
application each time an upload happens 
during unsolicited or unattended mode. 

Select CSID to use Based on whether you are connecting with 
an unprogrammed panel, or a panel that is 
already downloaded, select First Time or 
Station.

 ATTENTION: If this is not correctly 
selected, it affects the Incoming call and 
CPC connection.

Phone line Hunt group This option only affects panels that require 
callback and if you are using multiple 
unattended servers on a phone line hunt 
group. 

If a PC initiated Unattended batch 
connection is attempted and the panel 
requires callback, the CSID for the specific 
account is saved along with the time that 
the panel hung up to do the callback. The 
panel then calls back in 35 seconds. 

If a phone line hunt group is used, the 
panel may call back to a different 
unattended server. The unattended server 
answers the call and finds out that it is a 
response to a call that the PC had initiated 
35 seconds back. 

The server tries to save the CSID instead 
of the default CSID usually attempted for 
unsolicited uploads. 

All PCs running as unattended servers 
must have their clocks set accurately within 
one minute of each other.

Select action after Upload All:

If account exists: Select one of the following:

Disconnect Disconnect from Panel

Download Account CSID to 
Panel

Download the Account CSID information 
from the PC to the panel

if account does not exist: Select one of the following:

Disconnect Disconnect from Panel
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Scheduling Ademco Unattended Jobs
To schedule Ademco Unattended jobs, perform the following steps:

Download Account CSID to 
Panel

Download the Account CSID information 
from the PC to the panel

5 Click OK.

The COM Port is started. The Subscriber Information, Panel Information, 
details of the scheduled jobs, and the Activity Log are displayed in the 
Scheduler Activities Viewer. 

Figure 8-4 Scheduler Activities Viewer - Activity Log

6 You can print the Activity Log, save it as a text file or simply clear it from the 
screen using the relevant buttons at the bottom of the screen.

7 To stop the activity of the Com Port, click the Stop button above Panel 
Information. 

To restart, click Start. 

The Setup screen is again displayed for configuration.

Step Action

1 Follow the steps for starting the unattended server as detailed in  Starting the 
Unattended Server .

2 To schedule an unattended job, click the account in the Customer grid. Click 
the Schedule button located in the Panel Options area of the screen.

The Scheduler is displayed as illustrated below:
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3 Select the commands to be scheduled and move them to the Selected 
Commands list.

 REFERENCE– INTERNAL:  For more information on selecting 
commands, refer to 8.1 Selecting a Command.

4 Select the start and end dates, and the start and end times.
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5 Click Schedule. 

The following screen is displayed: 

6 Note that PC and Panel are the only “Initiate from” options available here. 
Select one of them, based on whether you want the call to be made by the PC, 
or the Panel.

7 Select the Answering Machine Defeat and Increase Priority options if 
required. 

 ATTENTION: When you select the Increase Priority option, the job is 
placed high on the list of tasks and run before other less priority jobs. This 
feature is applicable only for Unattended mode.

8 Type the Panel Phone number.

 TIP: To save this phone number, click Save. 

If this phone number is for this session only, and you do not want to overwrite 
an already saved number, click Undo at the end of the session. The previous 
phone number is retained.
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9 To use the TCP/IP connection, select Enable TCP/IP. 

10 Select the required option for Connection Mode - Direct Wire or ECP, based 
on whether you want to connect to the Panel through Direct Wire or through 
ECP.

11 If you want to communicate over the Intranet, select the option Private LAN 
and select  Central Station 1 IP and/or Central Station 2 IP from a list of the 
7810iR Device names that you have configured through File -> Device and 
Computer Names/ IP Addresses.

 REFERENCE– INTERNAL:  For more information, refer to 2.4 
Mapping Devices to IP.

12 If you want to communicate with the panel over the Internet (through 
AlarmNet-i Control Server), select the option AlarmNet-i. 

 REFERENCE– INTERNAL:  For information on configuring the 
Alarmnet-i URL, refer to 2.2 Setting up the Modem.

13 Click Schedule.

14 The scheduled tasks are taken up and completed on priority. You can view the 
details of the processing in the Activity Log of the Scheduler Activities 
Viewer.
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How the Ademco Unsolicited Mode works

Preparing the Server to Receive Unsolicited calls
To prepare an Ademco server to receive unsolicited calls, perform the following steps:

15 The Viewer-[Customers] screen shows the status of the batch. For 
information on the individual tasks, click Information. Click Commands to 
see the status of commands execution. Click Activity Log to see a listing of 
all the activities since the batch was scheduled.

 REFERENCE– INTERNAL: For more information on accessing the 
Viewer screen, refer to 7.3 Viewing Scheduled Jobs .

Step Action

1 Start the unattended server as detailed in  Starting the Unattended Server . 

2 Select the Server Type as Ademco and select the corresponding Port Name.

3 Select Unsolicited Server in Server Mode.
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Working of the Ademco Unsolicited Mode

4 Select the action to be taken when the panel calls in. 

The Unsolicited Setup Screen prompts the operator to define the actions that 
the Server must perform after uploading data from the panel (described in 
section  Setting up Ademco Unattended Mode ).

5 Start the Server in Answer mode so that any incoming calls are answered. 

Step Action

1 The panel calls the Compass Downloader.

2 The server identifies the panel type, and the panel information is uploaded to 
the server.

3 The server extracts the primary phone number information just uploaded and 
determines if a receiver group is assigned to that phone number. 

It checks for this within the Receiver Group/CS Phone number table previously 
set up by the operator.

 REFERENCE– INTERNAL: For more information on Receiver Group 
assignment, refer to 7.2 Assigning Receiver Groups.

4 If the primary phone number has a receiver group assigned to it, then the 
assigned receiver group together with the account number sent from the panel 
is defined as the unique Compass Account number within the Downloader.

If the account already exists, and the panel type is correct, unsolicited 
operation continues. If this unique Compass Account number does not exist in 
the Downloader, then the Downloader generates a new number.

5 If a primary phone number does not have a receiver group assigned to it, then 
the receiver group is assigned a value of "??????", indicating that this record 
is incomplete. 

The defined Compass Account number is "??????" and the account number 
sent from the panel. 

Note that this defined Compass Account may not be unique. If this unique 
Compass Account number does not exist in the Downloader, then the 
Downloader generates a new number.
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Setting Up an Ademco Panel to Call an Unsolicited Server
To setup an Ademco panel to call an unsolicited server, perform the following steps:

6 After a Compass Account has been identified, the Server checks for jobs 
scheduled to be done with the panel initiated option and those tasks are 
executed based on priority. 

If no jobs are found, it performs actions pre-defined by the operator in the 
Unsolicited Setup screen. 

Step Action

1 Program the primary phone number, account number, and download phone 
number in the Ademco panel. 

2 Ensure that the primary phone number has a receiver group assigned to it 
within the Downloader. 

 ATTENTION: This phone number field does not take any characters 
other than numbers. 

 REFERENCE– INTERNAL: For more information on Receiver 
group assignment, refer to 7.2 Assigning Receiver Groups.

During the handshake between the Server and the Ademco panel, the 
Ademco panel passes the programmed account number. 

After the connection between the Server and the Ademco panel is established, 
the Server requests an upload so that it can retrieve the primary phone 
number programmed. As mentioned above, the Server uses the primary 
phone number and account number programmed to determine the Compass 
Account.
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7.6  FBII Unattended Communications

Setting up FBII Unattended Mode
To select FBII Unattended Mode, perform the following steps:

Scheduling FBII Unattended Jobs 
To schedule FBII Unattended jobs, perform the following steps:

Step Action

1 Start the Unattended Server.

 REFERENCE– INTERNAL: Refer to  Starting the Unattended Server .

2 Select the Server Type as FBII from the drop-down list and select the 
appropriate port. 

3 Click Setup. 

The following dialog box is displayed:

4 Select the required options and click OK. 

 REFERENCE– INTERNAL: For more information on the options, see 
Step 4 of  Setting up Ademco Unattended Mode .

Step Action

1 Start the Unattended server.

 REFERENCE– INTERNAL: Refer to Starting the Unattended Server 
.

2 To schedule an unattended job, click the account in the Customer table. 
Then click the Schedule button located in the Panel Options area of the 
screen.

The Scheduler is displayed.
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3 Select the commands to be scheduled and move them to the Selected 
Commands list.

 REFERENCE– INTERNAL:  For more information on selecting 
commands, refer to  8.1 Selecting a Command.

 ATTENTION: Note that the FBII protocol does not allow selection of 
some of the commands multiple times, unlike Ademco. However, you can 
select any number of different commands.

4 Select the start and end dates, and the start and end times.

5 Click Schedule. 

The Communications screen is displayed. 
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How the FBII Unsolicited Mode works
The FBII unsolicited mode of working is as follows:

Setting up the FBII Panel to Call Unsolicited Server
The FBII panel can call the Unsolicited server if the Unattended Account ID number is programmed in 
the FBII panel Dialer. This value is retrieved from an existing Compass Account. 

To ensure that the right Account ID is programmed, perform the following steps:

6 In Connection Details, select the options as required. 

The 2 Call Method is the same as Answering Machine Defeat in Ademco. 

 TIP: When you select the Increase Priority option, the job is placed 
high on the list of tasks and run before other less priority jobs. This feature is 
applicable only for Unattended mode.

 REFERENCE– INTERNAL: For more information on Answering 
Machine Defeat , refer to  Configuring for Answering Machine Defeat. 

7 Type the Panel Phone number, and click Schedule.

Step Action

1 The Unattended Server is started, and listens for incoming calls.

2 The panel calls in.

3 The server identifies the panel type and extracts the Unattended ID from the 
panel. The Unattended ID from the panel is used for locating the correct 
Compass Account within the Downloader.

4 After the Compass Account is found, the server downloads the Compass 
Account data to the panel.

5 The scheduled jobs are executed. 

Step Action

1 In the Compass Customer Screen, find or create the Compass Account of 
interest. 
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7.7  Apex Unattended Communications

Starting Apex Unattended Mode
To start Apex Unattended Mode, perform the following steps:

2 Highlight the Compass Account and press the following keys: 
<Shift>+<Ctrl>+?. The account information is displayed as below. 

3 Verify that the Account ID value is the same as the unattended ID value in the 
FBII panel's Dialer. 

After this is done, the FBII panel can call the Server at any time. 

 ATTENTION: In the Panel Dialer, the account ID must be exactly 12 
digits. If the Account_Id is 4, the number in the panel would be 000000000004.

Step Action

1 Start the Unattended Server.

 REFERENCE– INTERNAL: Refer to  Starting the Unattended Server .

2 Select the Server Type as Apex from the drop-down and select the 
appropriate port. 

3 Click Setup. 

The following dialog box is displayed:
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Scheduling Apex Unattended Jobs 
To schedule Apex Unattended jobs, perform the following steps:

4 Select Auto Save Uploaded data and click OK. 

Step Action

1 Start the Unattended server.

2 To schedule an unattended job, click the account in the Customer grid. Click 
the Schedule button located in the Panel Options area of the screen.

3 The Scheduler is displayed. 

4 Select the commands to be scheduled and move them to the Selected 
Commands list.

 REFERENCE– INTERNAL:  For more information on selecting 
commands, refer to 8.1 Selecting a Command.

5 Select the Start and End Dates and Start and End Times in Schedule.
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6 Click the Schedule button at the bottom of the screen. This button is enabled 
only if any commands are selected.

The following screen is displayed: 

7 Type the Panel Phone number, and select the Answering Machine Override 
Digit. 

The PC Access Code is passed internally, so you need not type it. 

 ATTENTION: When you select the Increase Priority option, the job is 
placed high on the list of tasks and run before other less priority jobs. This 
feature is applicable only for Unattended mode.

8 Click Schedule.
R2.0 Compass 2.0 User Guide 123
07/10 Honeywell



Selecting a Command
8.  On-Line Commands
Irrespective of whether the panel is Ademco, FBII, or Apex, many on-line commands are common 
across them. All the commands may not be valid for all the panels. 

These commands are common for the Interactive mode and the Unattended mode. The only 
difference is that in the Unattended mode the screens asking for user input during command execution 
are not displayed. 

Instead, the Command Details screen is displayed during the scheduling.

8.1  Selecting a Command
You can select and de-select commands using the following buttons:

Other Tools

REFERENCE- INTERNAL

For more information on Command Details, refer to  Single Window for 
Configuring Multiple Commands .

Button Click this to…

Move commands to the Selected Commands list.

 TIP: You can also select a command by double-clicking the 
command, or using the drag-and-drop method described in section 
1.4 of this user guide.

Move commands from the Selected Commands to the Commands 
list.

Move all commands from the Selected Commands to the 
Commands list.

Tool Use this to…

Stop the execution, and cancel the command. This is enabled 
when the selected commands are being processed. 

It is placed below the Selected Commands list. This is not available 
in the Unattended mode.

 ATTENTION: This button is disabled for some lower end 
panels.
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8.2  List of Commands
A comprehensive list of commands and their description is provided in the following table: 

Remove the completed or failed tasks from the Selected 
Commands list. 

It is placed below the Selected Commands list. This is not available 
in Unattended mode.

Deselect all the highlighted commands at once.

It is placed below the Commands list.

Edit a selected command. 

It is placed to the right of the Selected Commands list. 

 ATTENTION: This tool is enabled only when the user input 
is taken for a command as in Arm/Disarm or Timeset. It is disabled 
for other commands.

Move the selected commands up or down to prioritize a task. 

It is placed to the right of the Selected Commands list.

Command Description

Arm Arm the panel from the downloader. You have to 
specify the area, when prompted

ChangePhone Change the download phone number

Clear Relays Clear relay information

Clear Tamper Clear tamper information

Clear Zone Lockouts Clear zone lockouts information

CsidChange Change the Central Station ID

DialerOff Switch-off dialer from the monitoring station

DialerOn Switch-on dialer from the monitoring station

DirectConnect Connect the downloader to the panel by a RS232 
cable

Disarm Disarm the panel from the downloader. You have to 
specify the area, when prompted.

Download All (w/o RF) Download all information except the RF data

Download All (w/o User 
Codes)

Download all information except the user codes

Download All (w/User Codes) Download all information, including the user codes

Download Ambush Download ambush details

Download Auto Arming Times Download auto arming times details

Download BA Options Download burglary alarm details
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Download Comm Download communication details

Download Ctrl Set Options Download control set options details

Download Device Options Download options configured for the device

Download Group Download group details

Download Holiday Download holiday schedules

Download Keypad Information Download keypad information to the panel

Download Loop / Point Download loop and points details

Download Pass Code Download pass code details

Download RF This command is used only when the optional RF 
Expander module is installed

Download Temporary 
Schedule

Download temporary schedules to the panel

Download User Codes Download only user codes to the panel

DownloadAccessData Download access data to the panel

DownloadAlarmTypes Download alarm type data to the panel

DownloadAll Download all programming information to the panel

DownloadAlpha Download panel Alpha display strings

DownloadRelay Download relay information to the panel

DownloadSchedule Download all schedule information to the panel

DownloadSystem Download system information to the panel

Download TroubleTypes Download trouble type details

ECPList Upload ECP device details

Engineer Reset Perform Engineer reset to control panel

EventLogAlarms Get event log regarding alarms from panel

EventLogAll Get event log regarding all events from panel

EventLogBypasses Get event log regarding bypasses from panel

EventLogClear Clear an existing event log from the panel

EventLogOpenClose Upload event log of Open/Close details

EventLogReset Clear all events in the control panel

EventLogSystem Get event log regarding system events from panel

EventLogTested Get event log of system test events

EventLogTroubles Get event log regarding troubles from panel

EventLogUpload Upload an event log from the panel
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FireTest Upload the fire test results from panel

Message Send message for display on panel

PhoneLockOutOff Prevent users from changing the Primary phone 
number

PhoneLockOutOn Allows users to change the Primary phone number

PointBypass Bypass a point

ProgrammableOutput Turn a programmable output device ON or OFF

RelayBurglary Report burglary to the monitoring station

RelayFire Report incidence of fire to monitoring station

RelayOpenClose Trigger Open/Close relay

RelayPanic Trigger panic relay

RelayRemoteSiren Trigger remote siren relay

Reset Swinger Count Clear swinger count

Set Relay Set a relay

Shutdown DialerOff Shut down the panel dialer functionalities (suspend 
the Dialer operation in a panel)

Shutdown DialerOn Restore operation of panel dialer functionalities 

Shutdown SystemOff Shutdown the system functionalities. (suspend panel 
operations)

Shutdown SystemOn Restore panel operations

SilenceReset Disarm the panel

SounderOff Switch off the sounder

SounderOn Switch on the sounder

Status Get the status of the panel that is on-line with the 
downloader

StatusAlarms Get the Alarms status in the panel 

StatusAlarmsHistory Get the Alarms history status in the panel 

StatusBypasses Get the Bypass Status in the panel 

StatusFaults Get the Faults status in the panel 

StatusLowBattery Get the LowBattery Status in the panel

StatusTroubles Get the Troubles Status in the panel

StatusTroublesHistory Get the TroublesHistory Status in the panel

TimeRead Read the time from the panel

TimeSet Set the time to the panel
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UnBypassZone Unbypass a zone

Upload All (w/o RF) Upload all information other than RF details from the 
panel

Upload Ambush Upload ambush details

Upload Auto Arming Times Upload auto arming times from the panel

Upload BA Options Upload burglary alarm details from the panel

Upload Comm Upload communication details

Upload Ctrl Set Options Upload control set options from the panel

Upload Device Options Upload device options from the panel

Upload Group Upload group details from the panel.

Upload Holiday Upload holiday schedules from the panel.

Upload Keypad Information Upload keypad information from the panel

Upload Loop / Point Upload loop and point details

Upload Pass Code Upload pass code details

Upload RF Upload RF data. This command is used only when 
the optional RF Expander module is installed.

Upload Temporary Schedule Upload temporary schedules from the panel

Upload User Codes Upload only user codes from the panel

Upload Zone Info 1 Upload information regarding zone 1

Upload Zone Info 2 Upload information regarding zone 2

Upload Zone Info 3 Upload information regarding zone 3

Upload Zone Info 4 Upload information regarding zone 4

Upload Zone Info 5 Upload information regarding zone 5

Upload Zone Info 6 Upload information regarding zone 6

UploadAccessData Upload access data from the panel

UploadAlarmTypes Upload alarm type data from the panel

UploadAll Upload all programming information from the panel

UploadAlpha Upload panel Alpha display strings

UploadRelay Upload only relay information from the panel

UploadSchedule Upload schedule information from the panel

UploadSystem Upload system information from the panel

Upload TroubleTypes Upload trouble type details

Zone Status Get the status of the zone. Specify the zone.
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8.3  Descriptions
Some commands, such as Timeset, Arm, or Bypass, require additional information (like the time to be 
set, or area to be armed). A separate dialog box is displayed on selecting these commands, asking for 
user input.

Changing CSID and Phone Number – Ademco
You can change the existing CSID or the Phone Numbers using the CsidChange and 
ChangePhone# Commands in the Scheduler. 

Changing CSID
To change CSID, perform the following steps:

ZoneBypass Bypass faulted zones via the downloader. Specify 
the zone.

Step Action

1 Double-click CsidChange in the Scheduler Commands list in the Scheduler to 
select it. 

The Change CSID dialog box is displayed.

2 Select your option based on the guideline below:

Option Description

CSID in Station Data CSID that exists under File/Station 
Data.

CSID in Account Record CSID that was saved in the Modify 
screen (panel).

First time CSID Default CSID of the panel.

Choose CSID Enter any 8-digit CSID.

3 Click OK.
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Changing the Phone Number
To change phone number, perform the following steps:

Step Action

1 Double-click ChangePhone# in the Scheduler Commands list to select it. 

The Change Phone Number dialog box is displayed.

2 The existing phone number for this panel is displayed on the left side of the 
Change Phone Number screen. 

For each phone number, the Operator can:

keep the phone number as is (No Change)  

clear the phone number (Clear), or  

change the phone number (New Phone #)  

In case New Phone # is selected, type the new number in the box provided.

3 Click OK.
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Displaying Messages
To display messages on the panel, perform the following steps:

Step Action

1 Double-click Message in the Scheduler Commands list to select it. 

The Message dialog box is displayed.

2 Type the messages that need to be displayed on the panel, and select the 
message duration. 

You have a choice of sending the message to the single partition selected in 
Select Partition or all the partitions.

3 Click Send to send the message to the panel.
R2.0 Compass 2.0 User Guide 131
07/10 Honeywell



Descriptions
Arming/Disarming
To arm or disarm a partition, perform the following steps:

Setting the Time
To set the time in the panel, perform the following steps:

Step Action

1 Select Arm or Disarm as required. 

The Partition Selection dialog box is displayed. 

Figure 9-1 Arm/Disarm - Ademco

In FBII panels Arm/Disarm is a single option. The arm/Disarm dialog box is 
displayed.

Figure 9-2 Arm/Disarm - FBII

2 Select OK (Ademco) or Select (FBII) as the case may be.

Step Action

1 From the list of commands in the Communication screen, select Timeset. 
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2 Double-click Timeset or click the green arrow below the Commands list. 

The following screen is displayed: 

 ATTENTION: FBII and Apex protocols do not offer the option of 
entering the desired date and time. They use the Present Date and Time by 
default. 

 TIP: In Guardian Panels, the time and date are displayed automatically 
according to the time zones programmed in the panel.

3 The current date and time is displayed by default under both Present Date 
and Time, and Enter Desired Date and Time. While you cannot make 
changes to the former, the Desired date and time section allows editing.

4 Click OK.
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Viewing Event Log (Ademco)
To view Event Log in Ademco panels, perform the following steps:

Step Action

1 Select EventLogAll from the list of commands. 

The Get EventLog From Panel dialog box is displayed.

 ATTENTION: In case of non partition or if only one partition is selected, 
the Select Partition option is not displayed.

2 You have the option of viewing the log, or uploading it. 

If Upload Event log is selected, you can specify if you want a partial upload or 
a full upload. 

3 Select the partition on which the command is to be executed.

4 Click OK.
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Shutting Down a Panel (Ademco)
To shut down an Ademco panel, perform the following steps:

Step Action

1 Select the required shutdown command from the list of four shutdown 
commands available. 

2 Double-click the command or click the green arrow below the commands list.

The following screen is displayed:

 ATTENTION: Although you have selected four commands, only three 
are shown here. This is because the third one is Shutdown SystemOff. After 
this command is executed, the panel gets disconnected and we cannot 
execute any more commands

3 Select the partition for which the operation is to be performed. 

4 Click Ok.
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Bypassing a Zone 
To bypass a zone, perform the following steps:

ATTENTION

After the Shutdown System ON/OFF connection is executed, the panel is 
disconnected from the Compass. After Shutdown SystemOff, the panel 
operation is suspended.

Step Action

1 Select the ZoneBypass command. 

In Ademco Panels, the Zone Bypass dialog box is displayed. 

In FBII, the dialog box displayed does not ask for a partition selection.

2 Select the Partition and the Zone number to be bypassed if the panel is 
Ademco, or only the Bypass Zone in case of FBII.

3 Click OK or Select as the case may be.
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Sending a Test Report (Ademco)
To send a Test Report, perform the following steps:

Step Action

1 Select TestReport from the list of Commands in the Communication 
screen/Scheduler.

2 Double-click the command or click the green arrow below the commands list. 

The Request Test Report screen is displayed. 

3 Click OK.

 TIP :During the processing of the request, you will see a ‘*’ to the left of 
TestReport, which turns to a ‘#’ after the command is processed. If the command is not 
executed, the failure status is indicated by an ‘&’.
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9.  Database Management Utility

9.1  Overview
The Compass2.0 database contains information about configuration details for the intrusion control 
panel. It is essential that a backup of the information is taken on a regular basis. This chapter 
describes how to switch over the databases, backup, and restore the Compass2.0 database.

9.2  Change Database
If you have data stored across multiple databases or servers and if you want to switch between them, 
use the change database option

To change databases, perform the following steps:

ATTENTION

The change, backup, and restore operations requires access to the SQL 
Server. It is recommended to close all Compass2.0 applications that are open 
when the Database Management Utility operations are performed.

ATTENTION

When you change your database, the previous database data is not affected. 
You can again change the database to go back to the previous, if necessary.

Step Action

1 Choose Start > All Programs > Compass Windows Downloader > 
DatabaseManagementUtility. The Database Management Utility dialog 
box appears.
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2 Select Change Database option. The details of the active Compass 
database are displayed under Existing Database Option. The 
information is read only.

• Server Name - The name of the computer in which the active 
Compass database resides.

• Login ID - The login ID using which you can login to the SQL 
server.

• Database Name – The active Compass database name.

3 From the drop down list, select the name of the computer where the 
database you would like to switch to resides.
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9.3  Backup Database
The need of taking backup of Compass database arises when:

• Compass2.0 MSDE databases must be ported to SQL Express. The active version of 
Compass2.0 supports only SQL Express and not MSDE. The MSDE database can be backed 
up and restored to SQL Express.

• You want to ensure that another version of database is maintained in case there is a crash of 
the old database.

To take backup of a Compass database, perform the following steps:

4 Select the List only local SQL Servers check box to view all the 
servers in the local computer. To view all the servers in the network, 
clear the List only local SQL Servers check box.

5 Select one of the following server connectivity options.

• Windows authentication credentials of current user - Select 
this option if the credentials for logging on to Windows must be 
used for logging on to the database.

• Server authentication using the Login ID and password 
below - Select this option if the SQL Server user name and 
password must be used for accessing the Compass database. 
When you select this option, the following fields are displayed.

 ATTENTION: If you select Compass20 server from the drop down list, 
the server connectivity options are disabled as the Compass20 server is the 
local computer.

6 Click Fetch Databases from Server to obtain the list of databases 
present in the selected server. The list is refreshed in the Database 
drop down list.

7 Click Change Database. The Compass application points to the 
selected database.

ATTENTION

The format of the Compass database remains the same even after the 
database is restored to SQL Express.

Step Action

1 Choose Start > All Programs > Compass Windows Downloader > 
DatabaseManagementUtility. The Database Management Utility dialog 
box appears.
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2 Select Backup Database option. The details of the active Compass 
database are displayed under Existing Database Option. The 
information is read only.

• Server Name - The name of the computer in which the active 
Compass database resides.

• Login ID - The login ID using which you can login to the server.

• Database Name – The active Compass database name.

3 Select the database Server Name from the drop down list.

 ATTENTION: As the databases listed are only those present in the 
local server, by default, the List only local SQL Servers check box is 
disabled.
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9.4  Restore/Purge Databases

Restore Database
After the backup operation is complete, the database can be restored.The database becomes the 
active database only after it is restored.

To restore Compass database, perform the following steps:

4 Select one of the following server connectivity options.

• Windows authentication credentials of current user - Select 
this option if the credentials for logging on to Windows must be 
used for logging on to the database.

• Server authentication using the Login ID and password 
below - Select this option if the SQL Server user name and 
password must be used for accessing the Compass database. 
When you select this option, the following fields are displayed.

 ATTENTION: If you select Compass20 server from the drop down list, 
the server connectivity options are disabled as the Compass20 server is the 
local computer.

5 Click Fetch Databases from Server to obtain the list of databases present in 
the selected server. The list is refreshed in the Database drop down list.

6 Click Backup Database. A backup of the Compass database is taken and the 
extension of the database file is .bak in the current computer The database is 
stored in C:\CompassDatabase\Backup.

Step Action

1 Choose Start > All Programs > Compass Windows Downloader > 
DatabaseManagementUtility. The Database Management Utility dialog 
box appears
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2 Select Restore Database option. The details of the active Compass 
database are displayed under Existing Database Option. The 
information is read only.

• Server Name - The name of the computer in which the active 
Compass database resides.

• Login ID - The login ID using which you can login to the server.

• Database Name – The active Compass database name.

3 Select the database Server Name from the drop down list.
R2.0 Compass 2.0 User Guide 143
07/10 Honeywell



Restore/Purge Databases
Purge Database
After you delete the database from compass, it is not completely removed from the system. To remove

the database permanently from the system, you may use the purge option.

To Purge database, perform the following steps:

4 Select one of the following server connectivity options.

• Windows authentication credentials of current user - Select 
this option if the credentials for logging on to Windows must be 
used for logging on to the database.

• Server authentication using the Login ID and password 
below - Select this option if the SQL Server user name and 
password must be used for accessing the Compass database. 
When you select this option, the following fields are displayed.

 ATTENTION: If you select Compass20 server from the drop down list, 
the server connectivity options are disabled as the Compass20 server is the 
local computer.

5 Select Bak file from the drop down list. The list is refreshed in the 
Database drop down list.

6 Click Restore Database. The database is restored successfully to the original 
path.

Step Action

1 Choose Start > All programs > Compass Windows Downloader > 
Database Management Utility.

2 The following Screen appears. Choose Restore/Purge Database followed 
by purge database..
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9.5  Migrate Database
To migrate all the user accounts present in the MS Access database to a new database in the local 
SQL server, perrform the following steps:

3 Choose the appropriate Database and click purge Database.

4 Note:  All deleted databases will be present in the Backup folder. Only 
the files those are present in the C:\Compass\Database\Backup will only 
be available to purge and will be displayed in the Database dropdown.

 ATTENTION: If you purge the database, the .bak file will be deleted 
permanently from the backup folder. Before purging the database, please 
make sure that you select the appropriate .bak file,

Step Action

1 Choose Start > All programs > Compass Windows Downloader > 
Database Management Utility.
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9.6  Delete Database
To Delete database, perform the following steps:

2 The following screen appears. Choose Migrate database..

3 Click browse and perform the following:

Select the Compass 1.5.8.X directory on this computer to migrate your MS 
Access database to SQL Express.

Note:  The database folder can reside anywhere in your Hard Drive or 
even in your USB Drive. However do not keep it on your Desktop or 
any mapped network drives and try to open as it may have access 
privilege issues.

4 Copy the three .mdb files: Download.mdb, History.mdb, and E20001.mdb, as 
well as, the system.mda file from Compass installed on another computer, to a 
folder in this computer and then convert the database

Note:  The installation may take a while to migrate depending on the 
size of the database

Step Action

1 Choose Start> All programs > Compass Windows Downloader > 
Database Management Utility.
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2 The following Screen Appears. Choose Delete Database..

3 Click Fetch Databases from Server. The available databases are listed in the 
Database dropdown. Choose the appropriate one and click Delete Database 
button to delete the database.

 ATTENTION: Before deleting the database, ensure that no client is 
connected to the respective database. If the database is deleted from the 
server, the client ceases to work After deleting the database, a file with .bak 
extension will be created in the backup folder. If you want to use the same 
database, you can restore it from DBMU 
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9.7  Client Installation
The database backup and restore options in the Database Management Utility are available only 
with the Compass Standard installation. If Compass 2.0 is installed as a Client, the backup and restore 
options are automatically disabled.
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10.  Bug Reporter
Bug reporter is a newly added feature for diagnostic purposes to trace an issue when it is reported. It is 
primarily designed to extract all the log files and the system related information from the system that 
would help in analyzing the root cause of an issue to  give the fix for the same. Bug reporter creates a 
log file under C:\Windows\Compass_Logwith the extension '.clg'.

Bug reporter can be accessed in three ways:

• Access through Start up menu (choose Start>all programs>Compass Windows 
Downloader>Bug Reporter)

• Access through Compass application (Click Help> Report a bug)

• Access through Utility Folder (in the CD)

Access through Startup Menu
Choose Start>All programs>Compass Windows Downloader>Bug Reporter

Access through Compas Application 
Choose Help > Report a Bug
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Access through Utility Folder
Bug Reporter is accessible through a seperate folder that is provided inside the utility folder of the 
installation CD provided.
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11.  New Features in Compass 2.0

11.1  Overview
The new features in Compass 2.0 are summarized here.

• Drag and Drop Commands

• Common User Interface

• Single Window for Configuring Multiple Commands

• Simultaneous TCP/IP and dialup connection

• Activity Log

• Unattended/Unsolicited Mode Features

• Multiple Panel Usage

• Interactive Mode Features

• Export and Import Subscriber utilities

• Panels Report

• View all Customer Records

• Print Customer Detail

• Purge Event Log

11.2  Descriptions
Each of the new features is described in this section.

Selecting Commands using Drag-and-Drop
The drag-and-drop option is an alternative to the select and click method of selecting commands. This 
option is supported in both Interactive Communications and Scheduling mode for all the protocols. 

To select a command, click the command from the Commands list and drag it to the Selected 
Commands list before releasing the mouse button. You can select multiple commands in one 
operation before dragging them.

Figure 10-1 Drag and Drop Commands
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Common User Interface
The Communications UI for all the protocols share the same look-and-feel. Only the commands list 
differs from one panel to the other. 

You can identify the panel by the Panel Name.

Figure 10-2 Compass Communications UI

Single Window for Configuring Multiple Commands
If you have selected multiple commands that need user input for their processing, all the forms are 
displayed in a single window. This applies to both Interactive and Scheduled (Unattended) modes. 

For example, if you have selected the ChangePhone# and CsidChange commands, both of which 
require user input, these can be configured in one Command Details window as illustrated below:
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Figure 10-3 Common Window for Multiple Command Details

Connecting through TCP/IP and Dialup Simultaneously
You can execute unattended jobs (for different Panels) through dial up mode and TCP/IP mode 
simultaneously (at different Ports).

Activity Log
You can view or export the activity log in the interactive mode. If not required, you can disable this 
feature. The exported activity logs must be saved in a text format. 

To view the activity log, click Activity Log> View Activity Log in the menu bar of the Compass 
Communications screen.
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The Activity Log is displayed as illustrated below. It lists the Commands that were run, the status of 
execution, and the date and time when the commands were processed. It also displays some 
messages if a certain command could not be processed as desired.

Figure 10-4 Activity Log - Interactive

In the Scheduled Mode, the activity log generated can be saved in the text format, or printed.

Figure 10-5 Activity Log - Unattended

TIP

To access the Compass Communications screen, double-click the account 
in the Customer grid. Then, click Communications in the menu bar of the 
open panel.

REFERENCE- INTERNAL

For more information regarding Activity Log in the Unattended Mode, refer to 
step 10 of  Scheduling Ademco Unattended Jobs.
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Unattended/Unsolicited Mode Features
The following are some of the new features implemented in the Unattended Mode:

• A single UI caters to all the protocols and multiple ports.

• The Unattended UI shows details of the job in the queue.

• The Viewer UI shows the offline status message for an account.

• You can modify the commands that require user input, with new values, when rescheduling an 
Unattended batch.

• Compass 2.0 supports the Unattended mode for Apex. 

• When you launch the Unattended UI, you can use the Auto Save option to automatically save 
uploaded information in the Unattended mode.

Working with Multiple Panels
You can schedule jobs for any number of panels, even while one of the panels is open. Only jobs for 
the open Panel Application cannot be scheduled. You can schedule jobs for one panel, and while the 
job is executed, schedule the next (other than the open panel).

Interactive Mode Features
The following are some of the new features implemented in the Interactive Mode:

• You can stop the execution of a command before it is finished.

• The Event Log shows you the list of all commands that have been executed previously in the 
Interactive mode. This is a new feature for Apex and FBII protocols. The Event Log can be 
viewed from the Shell (View Log under Panel Options in the bottom toolbar) or from the 
Compass Communication screen (Event Log in the bottom Toolbar).

• You can view offline status messages for an account.

• Event Log, ECP Details and Fire Test Reports are saved automatically to the database. This is 
a new feature for Ademco protocol.

Export and Import Subscriber
This feature provides the ability to export/import customer information from the Compass application.

REFERENCE- INTERNAL

For more details on Unattended Mode and its features, refer to 7. Unattended 
Communications.

REFERENCE- INTERNAL

For more information on scheduling, refer to 7. Unattended 
Communications.

REFERENCE- INTERNAL

For more details on Interactive Mode and its features, refer to 6. Interactive 
Communications.
R2.0 Compass 2.0 User Guide 155
07/10 Honeywell



Descriptions
Exporting Subscriber Information
You can export the subscriber details into a text file or an Excel sheet using the Export Subscriber 
feature. 

To export the subscriber information, perform the following steps:

Step Action

1 In Compass 2.0 Shell, click Tools>Export Subscriber. 

The Define Export Sources dialog box is displayed.

2 Click Add. 

The Add Export Source dialog box is displayed. 

3 Type a Description to the export source (For example, Customer1) and click 
Ok. 

The column headings in the customer information screen are displayed in the 
Available Fields listbox.
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4 From the Available Fields list, select the fields that you want to export. 

Click the > arrow to move the fields to the Selected Fields list and the  

arrows to sequence the list in the order in which you want to export it. 

 TIP: The arrows help you move the fields between Available and 
Selected lists

• moves the selected item to the cursor position in Selected 
Fields

• moves the selected item to the end of the Selected Fields 
list.

• moves the entire list from Available Fields to Selected Fields

• moves a single Selected Field entry to Available Fields

• moves all Selected Fields to Available Fields

 ATTENTION: The import action can be performed only if the Reporting 
Format field is not included in the text file. So if the data needs to be imported, you 
must ensure that the Reporting Format is not one of the selected fields while exporting. 

5 In File Properties, specify the file type and format from the list of options. You 
can save the details as an Excel file or a text file. 

6 Click Export.

The Select Path to Export Subscribers dialog box is displayed.
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Importing Subscriber Information
The file generated using Export Subscriber can be imported to the customer screen. 

To import subscriber information, perform the following steps:

7 Type a name for the file. 

8 Select the desired destination and click Save.

9 Click Close in the Define Export Sources dialog box to close it.

The saved file (ExportCustomerInfo.txt) contains details of the subscribers as 
displayed on the customer screen of the Compass Shell.

Step Action

1 In Compass 2.0 Shell, click Tools>Import Subscriber. 

The Define Import Sources dialog box is displayed. 
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2 If the source is not defined, click Add and type a description for the source. 

 REFERENCE– INTERNAL: For more information on adding a new 
Import Source, refer to  Importing Information from Other Sources.

3 From Select Fields, select the appropriate Fields from the available fields.

4 From File Properties, select the format for the file imported.
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5 To preview the import source, click Preview. 

The Test “ImportSourceName” dialog box s displayed showing a preview of the 
Import file. The selected fields are displayed as columns in the same order of 
selection.

6 Click Preview in Test “ImportSourceName” to select the file that contains 
customer information, which was saved during export.

7 Select the exported file and click Open. 

The Test “ImportSourceName” dialog box is displayed with the records. 
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Descriptions
8 Click Close after viewing.

9 In the Define Import Sources dialog, type the account number from which the 
data importing should begin. Select Ignore Header Row if you do not want to 
import the header.

10 Click Import. 

The Import Subscribers dialog box is displayed. To start importing from a 
particular account number, type the number in the Starting Account No. text 
box.

11 Select a source from the Import Sources drop-down list, if it is not already 
displayed by default. 

12 Click Import.

The Import Subscribers from … dialog box is displayed.
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Descriptions
Import Subscribers – Options
With the Import Subscriber Options, you can choose to import details of a new customer, or modify 
information of existing accounts, or both.

Figure 10-6 Import Subscribers – Options

13 Select the required file and click Open.

14 The text boxes with a blue background, under Processing, show the status of 
processing of the Import command. 

15 Click Close to close the Import Subscribers dialog box.

16 The information in ExportCustomerInfo.txt is imported to the customer screen.
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Descriptions
Importing Information from Other Sources
The Export Source is available in the Import Sources list only if the export/import operations are done 
in the same Compass network. If you have to import a file given by any other source (third party) to 
your Downloader, follow the instructions given below:

Option Description

Default Import Action The default actions are:

Add Only –You can only add new accounts where the 
Receiver number-Account number combination is 
different.

Update Only – You can only update customer details of 
the accounts already present in the list. No new accounts 
can be added.

Add/Update – You can add new accounts or 
update/modify information of existing accounts.

Delete – You can delete the existing accounts.

Skip Action in Import File Import Action is a one character field that specifies the 
actions to take with records in the input file. It is one of the 
Available Fields in Define Import Sources dialog box.

You can select this option to skip the action mentioned in 
the Import File.

Select <Import Action>in Available fields and click Help 
for more details. 

Step Action

1 Click Add in the Define Import Sources dialog box. 

The Add dialog box is displayed.

2 Type the Description (name of the import source) and click Ok.

3 From the Available Fields list, select the fields that you want to import. 

Click the > arrow to move the fields to the Selected Fields list. To move the 
entire list, click 

4 Click Save. The selection is saved to the new import source.
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Descriptions
Panels Report
A new utility for generating a report on the panels being used by a Compass system is provided. 
However, this newly added feature can work with Compass 16 and does not require the installation of 
Compass 2.0.

Viewing All Customer Records
You can view all customer records from the Shell. A single page displays 1024 records. You can move 
to the next page or previous page.

Printing Customer Detail
To print customer details, perform the following steps:

You can print only the details of one customer at a time. The customer details are printed as illustrated 
below.

5 Follow the steps 3 to 16 of Importing Subscriber Information.

The data from the text file is imported to the Import source and is displayed in 
the same order as the Selected Fields.

REFERENCE- INTERNAL

You can also Export and Import Accounts. For more details refer to 4.9 
Exporting and Importing Accounts.

REFERENCE- INTERNAL

For more information refer to Exporting Panel Usage 9.4 Exporting Panel 
Usage.

Step Action

1 Select the row/customer whose details you would like to print from the 
Customer screen. 

2 From the File option in the menu bar, select Print. 

A form is displayed, which shows the customer details. 

 TIP: You can move to the first, last, previous, or next customer detail 

using the  button at the bottom left of the 
screen.

3 Use Print Setup to configure the details of printing.
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Descriptions
Figure 10-7 Printing Customer Detail

Purge Event Logs
Operators can now delete the Event Log data from the Compass database using this utility.

Other Important Features
The other important features of Compass 2.0 are:

• Templates for quick and easy programming of control panels.

 REFERENCE-INTERNAL: For more information, refer to 5.4 Using Templates. 

• A full search utility to help you quickly finds a programming field.

 REFERENCE-INTERNAL: For more information, refer to 4.5 Searching/Sorting Customer Data.

• Multi-tiered operator levels for greater flexibility.

 REFERENCE-INTERNAL: For more information refer to 3. System Operators.

• Change button to display programming changes made before saving.

• History button to display prior programming changes.

REFERENCE- INTERNAL

For more information, refer to Purging Event Logs 4.7 Purging Event Logs.
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APPENDIX A

Error Conditions

Error Solution

Cannot find a DLL or 
VBX file

Manually copy the files giving the error from the DLL subdirectory of Compass 
to the Windows/system directory. 

xx parameters 
expected, but none 
supplied

This error occurs if the database is not synchronized properly at the end of an 
installation. Try running the database synchronizer again. It is possible that a 
DLL or VBX was not properly moved to the Windows System directory, or that 
the Compass upgrade was installed onto a different directory and not the 
original directory. 

To see the directory where Compass was installed, run Compass and check 
the database path on the login screen. The beginning of this path, before the 
\database\download.mdb, is the location of the previous installation. If this 
path is not the same as the upgrade, change the path to match the upgrade 
directory. 

“Decode.dll” error 
message.

Report this error to Ademco for repair, along with the following information: 

• The panel type.

• The type of error: “vb value invalid”, “vb type length”, “nibble length”, etc.

• The glf_id and the repeat.

Export the account and send it to technical support.

 REFERENCE– INTERNAL: For information on technical support, refer 
to Technical Support.

Cannot find 
system.mda when 
repairing network 
database locally

This is caused when the Database Repair program cannot find system.mda in 
a local exe subdirectory, and the download.mdb in a local database 
subdirectory (For example: C:\compass\exe and c:\compass\database). 

Copy the system.mda into C:\ Compass\ database, then run the Repair utility.

Compass running on 
a Novell Server 
suddenly stops 
allowing anyone to 
add new accounts.

The reason for this error is that the Novell Server runs out of locks. Novell 
defaults are:

• Max Records per connection 500>>10,000

• Max File Locks per connection 250>>350

• Max Record Locks?>>20,000

"Permission denied, 
cannot open system. 
ldb" error message.

This error message may occur when running netload.exe from a peer-peer 
network. Netload.exe is designed to speed up a network installation. To solve 
this problem, perform the following steps:

Step  Action

1 Load the full installation on the network.

2 Change the shortcut for each of the client machines to run 
netload.exe from the server instead of download.exe on the local 
computer.
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3 Netload checks the network drive to see if any of the files in the 
exe, dll, or bitmap folders have been updated.

If any files are newer than those on the client machine, they are 
copied to the appropriate local c:\compass\ subfolder. The client 
machines are updated automatically without having to run an 
individual installation on each machine.

Alternatively, you can set up a partitioned drive (d:) on the server and install 
Compass to that drive. The server and all client machines can then run 
netload.exe. Only a network administrator can change these settings. The 
Head of the downloading department cannot typically change these settings.

"3041 Incompatible 
database” error 
messages.

This error occurs when the paging software is running in the background using 
an older version of either MSAJT200.DLL or MSAJT112.DLL. This software 
has loaded the older version of these dlls to memory. To fix this situation, don't 
run the paging software at the same time as Compass. Search to find these 2 
dlls on the system. Compass puts them into c:\windows\system.

It is likely that this paging software has the dlls in its local directory. If this is 
true, rename the dlls in the paging software directory to *.wdl. Let the paging 
software use the newer dlls installed and see if the two software packages can 
both run this way. Always start Compass first and then start the paging 
software so as to keep the newer dlls in memory.

muscle.vbx can not 
be located

If you are using Windows 95, 98, ME, or XP, copy the contents of the folder at 
X:\compass\dll (where X= server drive) to the local machine at 
C:\windows\system. If you are using Windows NT or 2000, copy the contents 
to C\winnt\system. 

Make sure to copy it to the system folder and not the system32 folder. Reboot 
the computer.

Error line: 6005 3044 
C:\compass\databas
e\ download.mdb 
isn’t a valid path

Perform a search for the file “download.ini”. It is located in the C:\windows or 
C:\winnt directory. 

Open the file and find the line “mdbpath=C:\compass\database.” Change this 
line to point to the database located on the server. For example, 
“mdbpath=X:\compass\database.” 

Click the File, and then Save. Close the file and run netload.exe.
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